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Overview
Welcome to the Aerospace SheetMetal Design User's Guide. This guide is intended for users who need to 
become quickly familiar with the Aerospace SheetMetal Design Version 5 product. 

This overview provides the following information:

●     Aerospace SheetMetal Design in a Nutshell

●     Before Reading this Guide

●     Getting the Most Out of this Guide

●     Accessing Sample Documents

●     Conventions Used in this Guide

Aerospace SheetMetal Design in a Nutshell

The Aerospace Sheetmetal Design workbench provides an associative feature-based modeling, making it 
possible to design sheetmetal parts in concurrent engineering between an unfolded or folded part 
representation.

Aerospace Sheetmetal allows you to define a part using predefined features. Both folded geometry and 
flattened geometry can be computed from the feature specifications.

The Aerospace SheetMetal Design User's Guide has been designed to show you how to design aerospace sheet 
metal parts of varying levels of complexity.

Before Reading this Guide

Before reading this guide, you should be familiar with basic Version 5 concepts such as document 
windows, standard and view toolbars. Therefore, we recommend that you read the Infrastructure User's 
Guide that describes generic capabilities common to all Version 5 products. It also describes the general 
layout of V5 and the interoperability between workbenches.

You may also like to read the following complementary product guides, for which the appropriate license is 
required: 

●     Part Design User's Guide: explains how to design precise 3D mechanical parts.

●     Generative Drafting User's Guide: explains how to generate drawings from 3D parts and assembly 
definitions.

 



To get the most out of this guide, we suggest that you start reading and performing the step-by-step 
Getting Started tutorial.

Once you have finished, you should move on to the next sections, which explain how to handle more 
detailed capabilities of the product.

The Workbench Description section, which describes the Aerospace SheetMetal Design workbench will also 
certainly prove useful. 

 

Accessing Sample Documents

To perform the scenarios, you will be using sample documents contained in the online\aslug\samples 
folder. When samples belong to capabilities common to different SheetMetal products, those samples will 
be found in the online\cfysa\samples\SheetMetal folder. For more information about this, refer to 
Accessing Sample Documents in the Infrastructure User's Guide.

 

 

 

Getting the Most out of This Guide



Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and 
understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task



functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or the Advanced Tasks

Workbench Description

Customizing

Reference

Methodology

Glossary



Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document window, 
...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?

New Functionalities

Hybrid Design
You can now create wireframe and surfacic features within the same solid body which impacts the 
behavior of webs, surfacic flanges and corner reliefs.

User-stamp
You can now create user-stamps.

Enhanced Functionalities

Joggle on Web
You can now create joggles on a web.  

Runout parameters
You can now define precisely the runout parameters of the joggles.

Cutouts
Additional possibilities are now available when creating a cutout: you can choose a direction for the 
cutout that is different from, or equal to, the normal direction. Additionally, the extrusion can now be of 
lesser length than the thickness. You can also now specify several supports for the cutout, instead of 
just one previously.

Flange pattern
You can now create a pattern from a flange on rectangular, circular or user-defined patterns.

Document chooser integration.
You can now customize the document environment (Tools/Options/General/Document tab) in order to 
select documents or paths using various interfaces (folder, Enovia, and so on). The interface can be 
customized for a folder or DLName path selection interface.
 

 
       

file:///E|/Www/cnqr14/Doc/online/cfyugprt_C2/cfyughybrid_design.htm
file:///E|/Www/cnqr14/Doc/online/cfyugbas_C2/cfyugbrowsewindow.htm
file:///E|/Www/cnqr14/Doc/online/cfyugbas_C2/cfyugbrowsewindow.htm


Getting Started
Before getting into the detailed instructions for using Version 5 CATIA - Aerospace Sheet Metal Design, the 
following tutorial provides a step-by-step scenario demonstrating how to use key functionalities.

The main tasks proposed in this section are: 

Entering the Aerospace SheetMetal Design Workbench
Defining the Aerospace SheetMetal Parameters

Creating a Web from a Sketch
Creating a Surfacic Flange on a Web

Creating a Cutout
Extracting Drawings from the Aerospace SheetMetal Design Part

 

 
All together, these tasks should take about 20 minutes to complete.



Entering the Aerospace SheetMetal Design 
Workbench

The Aerospace Sheet Metal Design functions are available when you are in the Part environment. Several 
functions are integrated from the Part Design workbench.

This task shows how to enter the workbench.

 

Choose the Mechanical Design -> Aerospace Sheet Metal Design item from the Start menu.
The Aerospace Sheet Metal toolbar is displayed and ready to use.

 



    
You may add the Aerospace Sheet Metal Design workbench to your Favorites, using the Tools -> 
Customize item. For more information, refer to the Infrastructure User's Guide.

 If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the 
View -> Specifications menu item or pressing F3.



Defining the Aerospace SheetMetal Parameters

This task shows you how to configure the Aerospace SheetMetal parameters.

1.  Click the Sheet Metal Parameters icon .

The Sheet Metal Parameters dialog box is displayed. 

2.  Change the Thickness if needed.

3.  Change the Minimum Bend Radius if needed. The Minimum Bend radius defines the minimum 

internal radius allowing the creation of a bend.

4.  Click OK to validate the parameters and close the dialog box. The Sheet Metal Parameters 

feature is added in the specification tree.

The other two tabs are not used in this scenario.

 

 



Creating a Web from a Sketch

This section explains how to create a web.

The web is the main feature of an Aerospace Sheetmetal Design part: there is always one (and only 
one) web.

1.  Click the Sketcher icon .

2.  Select the xy plane.

3.  Click the Rectangle icon  in the Profile toolbar to create the profile of the web.

 
4.  Click to create the first point and drag the cursor. 

5.  Click to create the second point: the rectangle profile is displayed.

6.  Click the Exit workbench  to return to the 3D world.

 

 

7.  Click the Web icon .

The Web definition dialog box is displayed.



 

 
8.  Select the sketch you just created as the support of the web.

A preview of the web appears.

9.  Click OK to create the web.

 

 

 Here is the web.



 

You can click the Sketcher icon  to edit the sketch.



Creating a Surfacic Flange on a Web

This section explains how to create a surfacic flange on a web, that is a feature which enables to stiffen 
the part.

The web is still open from the previous task.

1.  Click the Surfacic flange icon .

The Surfacic Flange definition dialog box is displayed.

 

 

 
2.  Choose the web as the Base Feature.

3.  Choose the yz plane as support.



 

 
4.  Click Preview to see the surfacic flange.

 

 
5.  Click OK to create the surfacic flange.

Here is the surfacic flange.

 

 



Creating a Cutout with a Sketch

In this task, you will learn how to: 
●     open a sketch on an existing face

●     define a profile on the face in order to create a cutout.

You can create a cutout defined either by a sketch or an open geometry.  

The surfacic flange is still open from the previous task.

1.  Select the surface from the geometry area to define the working plane.

2.  Click the Sketcher icon .

3.  Click the Elongated Hole icon  to create the contour.

To access the oblong profile, click the black triangle on the Rectangle icon. It displays a secondary 
toolbar.

 

4.  Click to create the first point and drag the cursor.

5.  Click to create the second point. The first semi-axis of the profile is created.

6.  Drag the cursor and click to create the third point. The second semi-axis is created and the 

oblong profile is displayed.

 



 

7.  Click the CutOut icon .

 

 
7.  Select the sketch.



 
The CutOut Definition dialog box is displayed and a cutout is previewed with default parameters.

The vectors show the side and the direction of the cutout.

 

8.  Select the Dimension type to define the limit of your cutout.

 
9.  Click OK. Here is your cutout.

 



Extracting Drawings from the
 Aerospace SheetMetal Design Part

This task shows how to create the Aerospace SheetMetal Design Part views in the Generative Drafting workbench.

The Sheet Metal part is displayed.

1.  Click  or select File -> New...

2.  Select the Drawing type and click OK.

The Generative Drafting workbench is launched.

The New Drawing dialog box opens.

 

3.  Click OK.

For more information about this workbench, refer to Generative Drafting User's Guide. 

4.  The drawing sheet appears.

5.  Tile the windows horizontally using the Window -> Tile Horizontally menu item.

6.  Select the Unfolded View icon  in the Projections toolbar from Generative Drafting Workbench.



This icon is added to the Projections toolbar provided the Sheet Metal workbench is present.

7.  Choose the xy plane in the Sheet Metal specification tree.

The unfolded view is displayed with the bends axes and limits.

Eventually, the Drafting sheet looks like this:

 

 



User Tasks
Managing the Default Parameters

Creating a Web
Creating a Surfacic Flange

Creating a Joggle
Creating Swept Walls

Unfolding
Creating a CutOut
Creating a Hole

Creating Stamping Features
Creating User-Defined Stamping Features

Creating a Local Corner Relief
Creating Constraints
Mapping Elements
Creating Corners

Creating Chamfers
Patterning

Reference Elements
Displaying Characteristic Curves

Looking For Aerospace SheetMetal Features
Browsing the Sheetmetal Catalog

Integration With Part Design



Managing the Default Parameters

This section explains and illustrates how to use or modify various kinds of features.
The table below lists the information you will find.

Using Aerospace Sheetmetal Design assumes that you are in a CATPart document.

Edit the parameters: select the Parameters tab and define the element thickness and bend radius 
values.

Compute the bend allowance: select the Bend Allowance tab and define the allowance value (K factor).

Define the compensations and runout: select the Joggles tab and define the compensations and the 
runout for the joggle.

 Please refer to the Customizing chapter to define the Sheet Standards Files.

 



Editing the Sheet and Tool Parameters

This section explains how to change the different sheet metal parameters needed to create your first feature.

1.  Click the Sheet Metal Parameters icon .

The Sheet Metal Parameters dialog box is displayed.

2.  Change the Thickness if needed.

 
3.  Change the Minimum Bend Radius if needed.

The Minimum Bend radius defines the minimum internal radius allowing the creation of a bend. 

4.  Change the Default Bend Radius if needed. To do this, you need to deactivate the formula first by right clicking the formula icon.

The Default Bend Radius corresponds to the internal radius and is linked by default to the creation of the surfacic flanges.

You can set the value to 0 to create bend with no radius. If using the DIN standard, the KFactor automatically sets to 0 as well.
Convention dictates that the inner angle between the two elements is used to define the bend.
It can vary from 0deg to 180deg exclusive. This angle is constant and the bend axis is rectilinear.

5.  Click OK to validate the Sheet Metal Parameters.

 
The Standard field displays the Standard to use with the part, if implemented. The name of this standard file is defined in a Design Table.

Parameters can be defined in a Design Table. To do so, press the Sheet Standards Files... button to access the company defined standards, if need be. For more information, refer to the Customizing Standard Files section.

To know more about the different ways to access you files, refer to the Opening Existing Documents Using the Browse Window section.

All parameters hereafter, or only some of them, can be defined in this Design Table:

file:///E|/Www/cnqr14/Doc/online/cfyugbas_C2/cfyugbrowsewindow.htm


 Sheet Metal Parameters
●     Standard in Sheet Metal Parameters

●     Thickness

●     Minimum Bend Radius

●     Default Bend Radius

●     K Factor

●     Radius Table

Column associated in the Design Table
●     SheetMetalStandard

●     Thickness

●     MinimumBendRadius

●     DefaultBendRadius

●     KFactor

●     RadiusTable

Definition
●     sheet reference name

●     sheet thickness

●     minimum bend radius

●     default bend radius

●     neutral fiber position

●     path to the file with all available radii

In all cases, the Thickness parameter must be defined in the Design Table in order for the other parameters to be taken into account.

 Standard Names For Holes
●     Clearance Hole

●     Index Hole

●     Manufacturing Hole

●     Fastener Hole

Column associated in the Design Table
●     ClearanceHoleStd

●     IndexHoleStd

●     ManufacturingHoleStd

●     FastenerHoleStd

Definition
●     path to the Clearance Hole Standard file

●     path to the Index Hole Standard file

●     path to the Manufacturing Hole Standard file

●     path to the Fastener Hole Standard file

 Standard Names For Stamps
●     Flanged Hole 

●     Bead

●     Circular Stamp

●     Surface Stamp

●     Flanged CutOut

●     Curve Stamp

●     Stiffening Rib

Column associated in the Design Table
●     ExtrudedHoleStd

●     BeadStd

●     CircularStampStd

●     SurfaceStampStd

●     FlangedCutoutStd

●     CurveStampStd

Definition
●     path to the Flanged Hole Standard file

●     path to the Bead Standard file

●     path to the Circular Stamp Standard file

●     path to the Surface Stamp Standard file

●     path to the Flanged CutOut Standard file

●     path to the Curve Stamp Standard file

When a parameter refers to a path, another sub-Design Table will be associated to the corresponding feature.

 
Example for a hole standard file:
Main Sheet Metal Parameters Design Table

 

 Hole Standard 
Whenever a hole is created, a design table will associate its radius with a standard name.

 

 
Example for a stamp standard file:
Main Sheet Metal Parameters Design Table

 

Whenever a stamp is created, a design table will associate its dimension with a standard name.

  



Surface Stamp

  
Curve Stamp

 

  Circular Stamp
 

 

  Bead

 

  Flanged Cutout
 

  Flanged Hole
 

  Stiffening Rib
 



Computing the Bend Allowance

This section explains the calculations related to folding/unfolding operations.

1.  Click the SheetMetal Parameters icon 

.

The Sheet Metal Parameters dialog box is 

displayed.

The fourth tab concerns the bend allowance.

 Bend Allowance

 The bend allowance corresponds to the unfolded bend width.

 
 

bend < 90deg bend > 90deg 
 L is the total unfolded length

A and B the dimensioning lengths as defined on the above figure. They are similar to the DIN 
definition.

 
●     K Factor

 Physically, the neutral fiber represents the limit between the material compressed area inside the bend 
and the extended area outside the bend. Ideally, it is represented by an arc located inside the thickness 
and centered on the bend axis. 



The K factor defines the neutral fiber position:

W = α * (R + k * T)

where:

W is the bend allowance
R the inner bend radius
T the sheet metal thickness
α the inner bend angle in radians.

If β is the opening bend angle in degrees:

α = π * (180 - β) / 180

When you define the sheet metal parameters, a literal feature defines the default K Factor and a formula 
is applied to implement the DIN standard. This standard is defined for thin steel parts. Therefore the K 
Factor value ranges between 0 and 0.5.
The DIN definition for the K factor slightly differs. 

W = α * (R + k' * T/2)
Therefore k' = 2 * k and ranges from 0 to 1.

 This formula can be deactivated or modified by right-clicking in the K factor field and choosing an option 
from the contextual menu. It can be re-activated by clicking the Apply DIN button. Moreover, the limit 
values can also be modified.

      
 When a bend is created, its own K Factor literal is created. 

Two cases may then occur:

a.  If the Sheet Metal K Factor has an activated formula using the default bend radius as input 
parameter, the same formula is activated on the bend K Factor replacing the default bend radius 
by the local bend radius as input.

b.  In all other cases, a formula "equal to the Sheet Metal K Factor" is activated on the local bend K 
Factor.
This formula can also be deactivated or modified.

 Bend Deduction

 When the bend is unfolded, the sheet metal deformation is thus represented by the bend deduction V, 
defined by the formula:

L = A + B + V
(refer to the previous definitions). 

Therefore the bend deduction is related to the K factor using the following formula:

V = α * (R + k * T) - 2 * (R + T) * tan ( min(π/2,α) / 2)



 This formula is used by default. However, it is possible to define bend tables on the sheet metal 
parameters. These tables define samples: thickness, bend radius, open angle, and bend deduction. In 
this case, the bend deduction is located in the appropriate bend table, matching thickness, bend radius, 
and open angle. If no accurate open angle is found, an interpolation will be performed. 

     
 When updating the bend, the bend deduction is first computed using the previously defined rules. Then 

the bend allowance is deduced using the following formula:

W = V + 2 * (R + T) * tan ( min(π/2,α) / 2)

When the bend deduction is read in the bend table, the K factor is not used.



Defining the Compensations and Runout

This section shows how to select the appropriate method to define compensations when flattening a 
surfacic flange or a surfacic flange with a joggle.
Compensation is a modification of the standard calculation of the unfolding process which intends to best 
represent the material behavior.

 
You first need to define which method you want to apply by customizing design tables. To do so, proceed 
as explained in Customizing Standards Files To Define Methods for Compensations.

 

1.  Click the SheetMetal Parameters icon . The Sheet Metal Parameters dialog box is 

displayed.

 



 2.  Click the Joggles tab.

3.  In the Compensations combo list, select the method as defined in the SheetMetal 

Standard files:

●     None: no compensation is applied

●     Method 1 (= Method V4)

●     Method 2

If the method you chose is not the one defined in the SheetMetal Standard Files, a warning message is 
issued prompting you to select another method or the corresponding file.

You can click the information icon to display a schema explaining both methods. More information is 
available in Customizing Standards Files To Define Methods for Compensations.

 

 
4.  In the Definition combo list, select the runout definition:

●     External: this type of runout includes the Joggle fillets.

●     Internal: this type of runout excludes partially the Joggle fillets.

You can click the information icon to display a schema explaining both types of runout.



5.  In the Runout section, modify the formula's coefficient by clicking the up and down arrows.

The Runout formula corresponds to the coefficient multiplied by the depth. 

If you create a new part, you can modify the formula's coefficient.

If you work on a part created in a previous version, when you create a joggle a warning is displayed 
asking you to validate this parameter in the  Sheetmetal Parameters dialog box.

6.  Click OK in the dialog box to validate the compensations and runout parameters.

 



Creating a Web

This section explains how to create a web, that is the main feature of an Aerospace SheetMetal Design part.
 

Open the Web1.CATPart document.
 

1.  Click the Web icon .

The Web definition dialog box is displayed.

 

  

 
2.  In the Support field, select the support geometry in the specification tree. It can either be:

 

●     a plane (example from the Web from open geometry geometrical set).

The Material Direction is displayed, perpendicular to the geometrical support. You can reverse the direction by clicking the arrow.

 

 

 

 

 

 
●     a closed sketch (example from the Web from closed sketches geometrical set).

In our example, there are two closed sketches: the web will be calculated on the smallest part of the second sketch.

The Material Direction is displayed, perpendicular to the geometrical support. You can reverse the direction by clicking the arrow.

 

file:///E|/Www/cnqr14/Doc/online/aslug_C2/samples/Web1.CATPart


  

 
You can click the Invert Material Dir button to reverse the material direction of the web.

 

3.  In the Boundary field, in the case of an open geometry, select the elements that limit the support geometry. It can either be:

●     a list of elements (curves, surfaces, or planes)

●     one or more sketches

 

The elements must be selected consecutively.
 

 
They are displayed in the Boundary frame, in the order you have just chosen them, as well as in the 3D geometry.

 

  

  



  

 

 

When a closed profile can be built, a light preview of the web is available. Otherwise, click Preview.

 You can modify the selection by selecting an existing limit and using the following buttons to: 

●     add a limit after the selected limit (Add After)

●     add a limit before the selected limit (Add Before)

●     replace a limit (Replace)

●     remove a limit (Remove)

●     select a limit more than one time (Insert)

 

In the following example, we first select three elements to limit the web.
 

 

 



 Then we select Surface.1 and click on the pink sketch to add it to the web's definition.

Then we select Surface.1 again and click on the yellow sketch to add it to the web's definition.

 

 

Note that Surface.1 is displayed twice in the Web 
Definition dialog box.

 

 The Web is created according to several elements.  

 
●     select several limits to modify the existing limit (Multiple Sel). This option is available once you have selected Add After: the Limits to Add 

dialog box appears to let you select the limits.

●     remove all limits (Remove All)

 

 Once you have modified the selection, a light preview is available. You can click the Preview button to display the result of the web.  

When the profile is defined by a list of geometrical elements, the following operations are performed:

●     the curves are projected on the web geometrical support

●     the surfaces are intersected with the web geometrical support

 

4.  Click OK.
 

The web (identified as Web.1) is created and the specification tree is updated accordingly.



 

Features are displayed when editing Web.1's panel.  

 

 

 The sketches are aggregated under the web (identified as Web.xxx). Sketch.1 is displayed in No Show mode as it was only used to create the web.
 

 

In hybrid context, even though a web is created with several features, none are aggregated under the web in the specification tree.  

  

 Specification tree's behavior in hybrid context.

 

Specification tree's behavior in pre-hybrid context.  

 Yet, if you open a part created in a previous release, the specification tree will be displayed accordingly to the previous behavior.
Fore more information about Hybrid Design, refer to the Hybrid Design section.
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Creating a Surfacic Flange

This section explains how to create a surfacic flange on a web, or an existing surfacic flange (in that case, their 
fillets must not intersect).

Understanding the surfacic flange

When creating a surfacic flange, the bend is propagated along the whole base feature (with a continuity in 
tangency). 

 In certain cases this propagation prevents the surfacic flange from being relimited: it happens when the selected 
edge allows propagation of the bend.

 

Open the SurfacicFlange1.CATPart document. Create a web as shown in the previous task.

Here are the different elements taken into account when creating a surfacic flange: 
●     Base Feature

●     Support

●     EOP

●     Sides and Corners

●     Process

●     Compensations

1.  Click the Surfacic Flange icon .

The Surfacic Flange definition dialog box is displayed.
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Base Feature

In the Base Feature tab, the Bend Radius is of Constant type. It is set to the default bend radius of the 

part.

2.  You can modify the fillet Radius value by changing the driving equation: click the  icon.

The Formula Editor dialog box opens, you can modify the dictionary and the parameters.

Or you may need to deactivate the formula using the contextual menu on the field and choosing Formula -

> Deactivate before editing the value.

3.  Choose the web as the Base Feature.

Once you chose the base feature, the Support tab automatically displays. 

Support
 

 
4.  In the Support tab, choose the surfacic flange's geometrical support. It can either be a surface, a plane or a 

curve.

Make sure the support is big enough to be able to later define an EOP with a length from OML.
The OML is a curve created by intersecting the flange support and a plane perpendicular to the web and normal to 
the OML.



●     Exact: the selected support is to be used for the creation of the surfacic flange.

●     Approximation:  the support surface is approximated using a ruled surface. This ruled surface is defined from 
two curves: 

❍     the OML (in light blue), computed at the intersection between the support surface and the web plane.

❍     a curve parallel to the OML (in pink), computed at a distance equal  to the approximation length 

This mode enables you to compute the maximum deviation between the support geometry and the 
approximated surface.

 

 
●     Angle: the support of the surfacic flange can also be defined by a line, a curve, an angle or the edge of a base 

feature. The angle is constant and you can change its value using the spinners.

You can modify the Support Length generated by the curve and the angle. By default, the length is set to ten times 
the EOP (Edge of Part) length. If the default EOP length is higher than 100mm, you need to modify the surface 
length. 

 

The red angle is the angle taken into account when creating the surfacic flange.

 



5.  Define the vectors' directions.

The vectors show the Base Feature Direction, the Direction and the Material Direction according to the 

direction of the geometrical support of the surfacic flange. 

You can modify the directions by clicking the arrows.

 

 

The surfaces (or curves) used to define the support surface must be continuous in point and tangency.

     

EOP
 



 
6.  In the EOP (Edge Of Part) tab, you can define either:

●     a length from OML (Outer Mold Line): length between the curve defining the top of the surfacic flange and the 
OML,

●     an element FD (Folded): boundary element (either a surface that intersects with its surface, or a sketch, or a 
wire projected on its surface),

●     an element FP (Flat Pattern): curve or sketch defining the flattened profile of the surfacic flange. 

The element FP must be included within the limits of the surfacic flange support when folded.

 
7.  Click OK.

 

The Surfacic Flange (identified as Surfacic Flange.xxx) is created and the specification tree is updated accordingly.

Surfacic Flange with a length 
from OML of 15 mm

Surfacic Flange with Plane.2 (in 
pink) as Element FD



Surfacic Flange with EOP FP (in 
light blue) as Element FP

Unfolded view of the Surfacic 
Flange with EOP FP as Element 
FP. See Unfolding.

     



 

 
In the Sides and Corners tab, you can choose to define the following elements:

●     sides (intersection between the Base Feature and a curve) as: 
❍     standard: they are automatically defined at the web limit and the perpendicular plans are kept (in this case, 

the user does not have to define them)

❍     none: no side computed (only the EOP will define the profile of the Flange)

❍     element FD (Folded): they are defined by a folded  geometrical element (curve, plane or surface). 

❍     element FP (Flat Pattern): curve defining the flattened profile of the flange.

Surfacic Flange defined with a 
Length from OML of 10mm, and 
Side 1 and 2 as Standard

Sides and Corners



Surfacic Flange defined with EOP 
FD as Element FD, and Side 1 
and 2 as None

Folded view of the Surfacic 
Flange with EOP FP as Element 
FP, Side 1 FP and Side 2 FP (in 
light brown) as Side 1 and Side 
2.
See Unfolding.



Unfolded view of the Surfacic 
Flange with EOP FP as Element 
FP, Side 1 FP and Side 2 FP (in 
light brown) as Side 1 and Side 
2.
See Unfolding.

a.  The following examples show two cases of a flange defined by an EOP FP or FD and Sides as None.

There is an intersection between 
the EOP and the web support -> 
the Surfacic Flange can be 
computed

There is no intersection between 



the EOP and the web support -> 

the Surfacic Flange cannot be 

computed

b.  The following examples show two cases of a flange defined by an element FD as the EOP and Standard 
sides.

There is an intersection between 
the EOP and the side -> the 
Surfacic Flange can be computed



There is no intersection between 
the EOP and the side  -> the 
Surfacic Flange cannot be 
computed

c.  The following examples show two cases of a flange defined by an element FP as the EOP and Standard 
sides.

There is an intersection between 
the OML and the EOP -> the 
Surfacic Flange can be computed



There is no intersection between 
the OML and the EOP -> the 
Surfacic Flange cannot be 
computed

d.  The following examples show three cases of a flange defined by an element FD as the side.

 

There is an intersection between 
the Element FD and the OML and 
between the side and the EOP -> 
the Surfacic Flange can be 
computed

  

 

There is an intersection between 
the side and the OML but no 
intersection between the side 
and the EOP -> the Surfacic 
Flange cannot be computed



  

 

There is an intersection between 
the side and the EOP but no 
intersection between the side 
and the OML -> the Surfacic 
Flange cannot be computed

e.  The following examples show three cases of a flange defined by an element FD as the side.

 

There is an intersection between 
the side and the EOP and 
between the side and the OML -
> the Surfacic Flange can be 
computed

 

There is an intersection between 



the side and the OML but no 
intersection between the side 
and the EOP -> the Surfacic 
Flange cannot be computed

 

There is an intersection between 
the side and the EOP but no 
intersection between the side 
and the OML -> the Surfacic 
Flange cannot be computed

  

Any cutout on the web will be taken into account to create the surfacic flange's sides. For example, if you create a 
cutout on the web, then create a surfacic flange with standard sides, the latter will be calculated from the web's 
profile including the cutout.
For optimization reasons, we advise you to first create a sketch with the desired shape, then create the surfacic 
flange.



The example above shows a 
Surfacic Flange with standard 
sides calculated from the web 
modified by a cutout (the cutout, 
shown in blue, is taken into 
account)

 You can create several surfacic flanges on a web already containing cutouts by selecting the web and the same 
support plane.

 In such a case, each surfacic flanges can be opened and modified independently from the other surfacic flanges. 
Yet, if the support of one of the surfacic flanges was to be modified, the change would be propagated to the other 
surfacic flanges.

●     corners (profile defined between the EOP and the sides) as: 
❍     none: no corner computed (only the EOP is able to define the profile of the Surfacic Flange)

❍     corner: between the side and the EOP (defined with a radius value)



The example above shows a 
Surfacic Flange defined with 
Sides 1 and 2 as Standard, and 
Corners 1 and 2 of 10mm each.

 

●     In the case the user does not define a surfacic flange side, the latter is automatically computed at the Web 
limit, perpendicular to the OML.

●     In the case no corner is defined, the side and the EOP are simply relimiting each other.

●     The sides of the fillet are continuous in tangency with the profile of the web and the sides of the surfacic flange.

     

 

Process
 



 In the Process tab, you can define the:
●     Manufacturing process:

❍     Hydropressed

❍     BreakFormed

●     K_Factor: you can modify the K Factor as defined in the SheetMetal Parameters dialog box by changing the 

driving equation.

Click the  icon. The Formula Editor dialog box opens, you can modify the dictionary and the parameters. Or 

you may need to deactivate the formula using the contextual menu on the field and choosing Formula -> 

Deactivate before editing the value. 

You can also choose to display the characteristic curves either on the folded view (Show curves in folded views), 

and/or on the flattened view (Show curves in flattened  view) of the part.

 

Compensations 
 

In the Compensations tab, you can define compensations for the: 
●     Joggle: 

❍     check the Apply Compensation button when creating or editing the joggle.
See Creating a Joggle for further information. 

Standard files and methods must be previously defined from the SheetMetal Parameters dialog box to have access 
to the Apply Compensation button. 

●     Surfacic Flange Sides (Side 1 and Side 2). 
❍     Define the type: 

■     None: no compensation is applied

■     Automatic: for symmetric flanges , A1=A2, so that the length of the flatten EOP = length of the folded 

EOP

■     Manual: Angle: the deformation is computed according to an angle 



■     Manual: Length: the deformation is computed according to a length parallel to the BTL. 

❍     Define the Angle in the case of a Manual: Angle compensation. A negative angle adds material, and a 

positive angle removes material. 

❍     Define the Length in the case of a Manual: Length compensation 

 

 

 

The values of the modification are the angles A1 and A2. 

 



●     Compensations can be created either on the folded or flattened part, but they only apply on the flattened part. 

●     Compensations can be modified independently on each flange. 

●     The + sign (in yellow in the 3D geometry) shows that material will be added to the sides. 

 

 

Unfolded Surfacic Flange defined 
with Corners 1 and 2 of 10mm 
each, and no compensation for 
Side 1 and Side 2  



Unfolded Surfacic Flange defined 
with Corners 1 and 2 of 10mm 
each, a Manual: Angle 
compensation of -20deg for Side 
1 and no compensation for Side 
2 

 

Unfolded Surfacic Flange defined 
with Corners 1 and 2 of 10mm 
each, a Manual: Angle 
compensation of 20deg for Side 
1 and -10deg for Side 2 

 Hybrid Design
●     In hybrid design context, when the edge of a part and/or the surfacic flange are defined by a sketch, they follow 

the hybrid design aggregation rules.

●     Yet, if you open a part created using an application release prior to Version 5 Release 14, the specification tree 
is displayed according to the rules implemented for that release.

For more information about hybrid design, refer to the Hybrid Design section.



Creating a Joggle

This task explains how to create a joggle, that is a feature which causes the main feature, that is, a surfacic flange or a web, to be locally 
deformed.

The joggle is a feature which cannot exist alone, it is always defined on a surfacic flange or a web.

 In the following example, you will create a joggle defined on a surfacic flange, yet, this description is also valid for a joggle created on a 
web.

Open the Joggle1.CATPart document. 

Create a surfacic flange as shown in the previous task.

1.  Click the Joggle icon .

 

2.  Select the surfacic flange or the web as the 

support.

The Support of the joggle is not automatically set to 

the last created feature (surfacic flange or web).

3.  Choose a plane as the joggle plane, here we 

choose Plane3.

The blue curve defines the boundary of the 

web.

The yellow line is a preview of the joggle.

The vectors show you the joggle directions:

- The vector on the surfacic flange or the web 
support determines the depth direction 

- The vector on the joggle plane determines 
the side on which the joggle is to be created

file:///E|/Www/cnqr14/Doc/online/aslug_C2/samples/Joggle1.CATPart


In case there are several intersections between the 
surfacic flange or the web and the plane, the closest 
intersection is chosen.

 

You can click the  icon to display a schema showing 

the joggle parameters to be defined.

4.  You can modify the following parameters of the joggle by clicking the up and down arrows.

●     depth: offset from the support surface (shown as dotted lines)

 
The dotted lines must remain inside the blue curve.

●     runout: length of the offset, between the original surface of the surfacic flange or the web and the new surface (joggle)

●     clearance: length added to the offset at the joggle starting plane

●     start radius: fillet between the runout and the surfacic flange or the web

●     end radius: fillet between the runout and the offset

5.  Click OK.

The joggle (identified as Joggle.xxx) is created and the specification tree is updated accordingly. 



●     If you modify the depth, the runout adjusts automatically, thanks to the formula applied to the runout parameters. If you do not want it 
to be adjusted automatically, right click on the runout field, select Formula ->Deactivate in the contextual menu.
If you want to have further information about the runout parameters, refer to the Defining the Compensations and Runout section.

●     You can reverse the runout direction either by clicking the red arrow or by clicking the Invert Runout Dir button in the dialog box. 

●     You can reverse the depth direction either by clicking the red arrow or by clicking the Invert Depth Dir button in the dialog box.

You cannot have a runout intersect with another runout. 

If you try to create a joggle on a web as well on the surfacic flange or if you create two joggles side by side that end up touching each 
other, an error message is displayed to prevent the runouts from intersecting with each other.

When creating a joggle on a web, you can choose the shape of the surfacic flange edge of part:

If you create an element above the part, for instance, a line, and want the surfacic flange edge of part to follow the line:

●     Open the Surfacic Flange Definition dialog box, 

●     Go to EOP tab and select Element FD or Element FP in the combo box.

If you would rather the flange edge of part to follow the joggle runout:

●     Open the Surfacic Flange Definition dialog box, 

●     Go to EOP tab and select Length From OML in the combo box.

 
 

Applying Compensations

You can apply compensations only on joggle defined on a surfacic flange. 

In the Surfacic flange dialog box, you can check the Apply Compensation option either on the folded or flattened part, but they only apply 
on the flattened part. 

Open the Joggle2.CATPart document for a single joggle, Joggle.3CATPart for a twin joggle, and Joggle4.CATPart for a double joggle. 

Standard Files must have been previously imported and a method for compensations defined. 

1.  Double-click the surfacic flange supporting the joggle to edit it. 

2.  In the Compensations tab, click the Apply Compensation button. 

 On a single joggle

 

Unfolded single joggle without compensations

file:///E|/Www/cnqr14/Doc/online/aslug_C2/samples/Joggle2.CATPart
file:///E|/Www/cnqr14/Doc/online/aslug_C2/samples/Joggle3.CATPart
file:///E|/Www/cnqr14/Doc/online/aslug_C2/samples/Joggle4.CATPart


 

Unfolded single joggle with compensations relying on Method 1 

 

Unfolded single joggle with compensations relying on Method 2 

 On a twin joggle

 

Unfolded twin joggle without compensations 

 

 

Unfolded twin joggle with compensations relying on Method 1 

 



 

Unfolded twin joggle with compensations relying on Method 2 

 

 On a double joggle

 

Unfolded double joggle without compensations 

 

Unfolded double joggle with compensations relying on Method 1 

 



Unfolded double joggle with compensations relying on Method 2 



Creating Swept Walls
This section explains and illustrates how to create and use various kinds of swept walls, i.e. walls based on a 
given profile that is swept along a spine.

Create a flange: select a spine, and set the radius, length, and angle values.

 Create a hem: select a spine, and set the radius, and  length values.

 Create a tear drop: select a spine, and set the radius, and  length values.

Create a user flange: select a spine, and a user-defined profile

Selecting the Spine
Whatever the type of the swept wall you wish to create, you first need to select one or more contiguous edges 
to make up the spine along which the profile, either pre- or user-defined, is to be swept. You can:

●     manually select one, or more, edge(s)

Selection without propagation Resulting flange without propagation
●     select  one edge and click the Tangency Propagation button: all contiguous and tangent edges are 

selected. In this case, would you need to remove one edge, you need to manually select it. Remember that 
only extremity edges can be removed without breaking the continuity between edges.

Selection with propagation Resulting flange with propagation



Creating a Flange 

This task explains how to generate a flange from a spine and a profile.

For the Generative Sheetmetal Design workbench, open the NEWSweptWall01.CATPart document.

For the Aerospace SheetMetal Design workbench, open the Aero_SweptWall01.CATPart document.

1.  Select the Flange icon  in the Swept Walls sub-toolbar.

 

 The Flange Definition dialog box is displayed. 

 
Note that the image in the right-hand pane of the dialog box is updated as you choose your parameters and options, 

and provides a graphical explanation about the current selection.

 

By default, the icon which is pre-selected next to the Angle field corresponds to an acute angle  for the Generative 

Sheetmetal Design workbench, and to an obtuse angle  for the Aerospace SheetMetal Design workbench.

2.  Select the edge as shown in red.

file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall01.CATPart
file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/Aero_SweptWall01.CATPart


 

 The Spine field is updated with the selected edge.

●     You can use the Remove All button to remove the selected edge(s).

●     You can use the Propagate button to select all tangentially contiguous edges forming the spine.

The drop-down list offers two choices: 

●     Basic: the flange is created along the whole support.

●     Relimited: the flange is created within limits you define on the support (points, for example). 

3.  Leave Basic selected. 

Selecting Relimited updates the dialog with two new fields (Limit 1 and Limit 2) to let you specify the flange limits. You can 
then select as the limits two points, two planar faces, a point and a planar face, or a point and a vertex, as shown below, for 
example. Note that right-clicking in the Limit 1 and Limit 2 fields lets you create the limits (points, plane) or choose the X, Y 
or Z plane on-the-fly.

 
 



 
4.  Choose the flange parameters:

●     Enter 15mm in the Length field. Use the icons  next to the field to specify the type of 

length. Note that the length is always computed using the lowest external point of the flange.

●     Enter 45deg in the Angle field. Use the icons next to the field to specify whether the angle is acute  or 

obtuse .

●     Enter 2mm in the Radius field.

 
5.  Check the Trim Support option to trim the selected edge.

●     The Trim Support option only works in the case of a planar support.

●     You cannot select Relimited and Trim Support at once. Indeed, lateral cuts in the sheet metal part are currently not 
supported when the support is trimmed (i.e. the flange must be created from one edge of the sheet metal part to the 
other). 

 
6.  Click the Reverse Direction button to reverse the direction of the flange.

7.  Click the Invert Material Side button to invert the material side. (This option is only available when the Trim Support 

option is checked, otherwise it is deactivated.)

8.  Click the More button to display the Bend Allowance tab allowing you to locally redefine the bend allowance settings. 

You may need to deactivate the formula using the contextual menu on the field and choosing Formula -> Deactivate 

before editing the value.



 

In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

A preview of the flange to be created is displayed in the geometry area.

 

9.  When you are satisfied with the result, click OK to create the flange. The flange is created and the feature is added to 

the specification tree.

file:///E|/Www/cnqr14/Doc/online/cfyugparameters_C2/cfyugsheetmetal01.htm




Creating a Hem

This task explains how to generate a hem from a spine and a profile.

The NEWSweptWall01.CATPart document is still open from the previous task.
If not, open the NEWSweptWall02.CATPart document from the samples directory.

1.  Select the Hem icon  in the Swept 

Walls sub-toolbar.

The Hem Definition dialog box opens.

 
Note that the image in the right-hand pane of the dialog box is updated as you choose your parameters and 

options, and provides a graphical explanation about the current selection.

2.  Select the edge as shown.

 The Spine field is updated with the selected edge.

file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall01.CATPart
file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall02.CATPart


●     You can use the Remove All button to remove the selected edge(s).

●     You can use the Propagate button to select all tangentially contiguous edges forming the spine.

The drop-down list offers two choices: 

●     Basic: the hem is created along the whole support.

●     Relimited: the hem is created within limits you define on the support (points, for example). 

3.  Leave Basic selected. 

Selecting Relimited updates the dialog with two new fields (Limit 1 and Limit 2) to let you specify the hem limits. You 
can then select as the limits two points, two planar faces, a point and a planar face, or a point and a vertex, for 
example. Note that right-clicking in the Limit 1 and Limit 2 fields lets you create the limits (points, plane) or choose the 
X, Y or Z plane on-the-fly.

 

4.  Enter 3mm in the Length field, and 2mm in the Radius field.

5.  Check the Trim Support option to trim the selected edge.

●     The Trim Support option only works in the case of a planar support.

●     You cannot select Relimited and Trim Support at once. Indeed, lateral cuts in the sheet metal part are currently not 
supported when the support is trimmed (i.e. the hem must be created from one edge of the sheet metal part to the 
other). 

6.  Click the Reverse Direction button to reverse the direction of the hem.

7.  Click the More button to display the Bend Allowance tab allowing you to locally redefine the bend allowance 

settings. 

You may need to deactivate the formula using the contextual menu on the field and choosing Formula -> 

Deactivate before editing the value.



In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

A preview of the hem to be created is displayed in the geometry area.

 

8.  When you are satisfied with the result, click OK to create the hem. The hem is created and the feature is added to 

the specification tree.

file:///E|/Www/cnqr14/Doc/online/cfyugparameters_C2/cfyugsheetmetal01.htm


 



Creating a Tear Drop

This task explains how to generate a tear drop from a spine and a profile.

The NEWSweptWall01.CATPart document is still open from the previous task.
If not, open the NEWSweptWall03.CATPart document from the samples directory.

1.  Select the Tear Drop icon  in the 

Swept Walls sub-toolbar.

The Tear Drop Definition dialog box 
opens.

 
Note that the image in the right-hand pane of the dialog box is updated as you choose your parameters and 

options, and provides a graphical explanation about the current selection.

2.  Select the edge as shown in red.

 The Spine field is updated with the selected edge.

file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall01.CATPart
file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall03.CATPart


●     You can use the Remove All button to remove the selected edge(s).

●     You can use the Propagate button to select all tangentially contiguous edges forming the spine.

The drop-down list offers two choices: 

●     Basic: the tear drop is created along the whole support.

●     Relimited: the tear drop is created within limits you define on the support (points, for example). 

3.  Leave Basic selected. 

Selecting Relimited updates the dialog with two new fields (Limit 1 and Limit 2) to let you specify the tear drop limits. 
You can then select as the limits two points, two planar faces, a point and a planar face, or a point and a vertex, for 
example. Note that right-clicking in the Limit 1 and Limit 2 fields lets you create the limits (points, plane) or choose the 
X, Y or Z plane on-the-fly.

 
 

4.  Enter 8mm in the Length field, and 3mm in the Radius field.

5.  Check the Trim Support option to trim the selected edge.

●     The Trim Support option only works in the case of a planar support.

●     You cannot select Relimited and Trim Support at once. Indeed, lateral cuts in the sheet metal part are currently not 
supported when the support is trimmed (i.e. the tear drop must be created from one edge of the sheet metal part to 
the other). 

 
6.  Click the Reverse Direction button to reverse the direction of the tear drop.

7.  Click the More>> button to display the Bend Allowance tab allowing you to locally redefine the bend allowance 

settings. 

You may need to deactivate the formula using the contextual menu on the field and choosing Formula -> 

Deactivate before editing the value.



In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

A preview of the tear drop to be created is displayed in the geometry area.

 

8.  When you are satisfied with the result, click OK to create the tear drop. The tear drop is created and the feature is 

added to the specification tree.

file:///E|/Www/cnqr14/Doc/online/cfyugparameters_C2/cfyugsheetmetal01.htm


 



Creating a User Flange 

This task explains how to generate a user flange from a spine and a user-defined profile.

The NEWSweptWall01.CATPart document is still open from the previous task.
If not, open the NEWSweptWall04.CATPart document from the samples directory. As a profile is already 
defined on the part, you will be able to skip step 2 of the scenario.

1.  Select the User Flange icon in the Swept Walls sub-toolbar.
 

The User Defined Flange Definition dialog box opens. 

 

 2.  If you are using the NEWSweptWall01.CATPart document, click the Sketcher icon , and 

define a profile in the yz plane as shown below:

file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall01.CATPart
file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall04.CATPart
file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall01.CATPart


Then quit the Sketcher, using the Exit icon .

If you are using the NEWSweptWall04.CATPart, go directly to step 3 as the profile is already 

defined.

3.  Select the edge and the profile, as shown in red.

4.  Click the More button to display the Bend Allowance tab allowing you to locally redefine the 

bend allowance settings. 

You may need to deactivate the formula using the contextual menu on the K Factor field and 

choosing Formula -> Deactivate before editing the value.

file:///E|/Www/cnqr14/Doc/online/cfysm_C2/samples/NEWSweptWall04.CATPart


In this case, the new K Factor value overrides the value set in the Sheet Metal Parameters.

5.  Click OK to create the user flange.

The feature is added in the specification tree.

●     Use the Remove All button to remove the selected edge(s).

●     Use the Propagate button to select all tangentially contiguous edges forming the spine.
 

file:///E|/Www/cnqr14/Doc/online/cfyugparameters_C2/cfyugsheetmetal01.htm


As far as the profile is concerned, remember that:
●     There must be a tangency continuity with the edge on which the flange is created,

●     The plane must be normal to the spine.

 



Unfolding
Unfolded Aerospace Sheet Metal parts can be displayed in two ways:

Folded/Unfolded View Access
Concurrent Access  

Each Aerospace Sheet Metal feature is created in a given view: folded, or unfolded. Editing a feature 
must be done in its definition view. If not, a message is automatically issued, prompting you to change 

views, before editing the feature.

  

 



Folded/Unfolded View Access

This task shows how to unfold the part. 

To perform this scenario, you can open any sheet metal sample provided in this user's guide.

1.  Click the Unfold icon .

The part is unfolded according to the reference wall plane or web, as shown below. 

2.  Click this icon  again to refold the part for the next task.

●     In SheetMetal Design, bend limits and stamping are now displayed in the unfolded view. However, 

cutouts created on stamps are not.

●     When designing in context, if a CATProduct document contains several sheet metal parts, only one 
part can be visualized in the unfolded view at a time.



Concurrent Access

This functionality is P2 for SheetMetal Design.

To perform this scenario, you can open any sheet metal sample provided in this user's guide.

This task explains how to display the sheet metal part in two windows: one with the folded view, one with the unfolded 
view. Any modification in one window is displayed in the other window.

1.  Click the Multi-view icon .

The part is unfolded in a second window.  

2.  Choose the Window -> Tile Horizontally menu item.

Both windows are tiled. Activate the window in which you want to work. 



●     Any modification in one view is taken into account in the other view enabling the user to make modifications in the 
best possible context.

●     In the multi-view mode as in the standard unfolded view, all constraints are displayed in the geometrical views.

●     Once in the Multi-view mode, the standard icon Unfold is not longer available.

●     The Multi-view function is not available from a standard unfolded view.

●     Only parts with bends can be unfolded.

●     Cutting faces and open faces are not displayed in Multi-view mode (SheetMetal Design)



Creating a Cutout

This task explains how to create a cutout.
Creating a cutout consists in extruding a profile and removing the material resulting from the extrusion. 

You can create a cutout defined either by a sketch or an open geometry.  

Open the CutOut1.CATPart document.

1.  Click the CutOut icon .

The Cutout Definition dialog box is displayed and the skin to be impacted by the cutout is displayed in a different color.

 

 

2.  Select a profile (sketch.1 in our 

example).

It can be either a sketch containing 

one or more shapes, a wire, or a 

part.

A preview of the projected cutout is 

displayed. The vectors show the 

side and the direction of the cutout.

 
Once the sketch is selected, you can modify it by clicking the Sketcher icon .

file:///E|/Www/cnqr14/Doc/online/aslug_C2/samples/CutOut1.CATPart


●     The Reverse Side option lets you choose between removing the material defined within the profile, which is the application's 
default behavior, or the material surrounding the profile. 

●     The Reverse Direction option allows you to invert the direction of the extrusion pointed by the arrow.

 
3.  Click OK in the Cutout Definition dialog box.

The cutout is created.

 

Several end limit types are available: 

●     Dimension: the cutout depth is defined by the value measured along the direction.

The depth corresponds to the base feature thickness.
Please refer to Editing the Sheet and Tool Parameters.

●     Up to next: the limit is the first face the application detects while extruding the profile. This face must stops the whole 

extrusion, not only a portion of it, and the hole goes through material.

●     Up to last: the application will limit the cutout onto the last possible face encountered by the extrusion.

4.  In the specification tree, double click on Cut Out.1 to display the Cutout Definition dialog box.

5.  Click More>> to display the maximum information.

The Direction is already selected (Sketch.1), that is perpendicular to the base feature.



 

Here the Cutout's impacted skin is set to Default, that is, the surface on which lies Sketch.1.

 

If you want to select another support for the cutout, click on  and select your new support. It can be a web, a flange or the 
planar part of the surfacic flange.
Specifying the support for the cutout avoid confusions in case of overlaps.

In the following example two flanges are overlapping each other. If you try to create a cutout on such a part, the following 
message is displayed:

To avoid this, you have to select the exact support for the cutout.



 

 
●     When Lying on skin is checked, 

❍     The End limit and Start limit types are automatically set to Dimension and disabled,

❍     The Depth is set to 0mm and disabled,

❍     The skin to be impacted is displayed on the part.

The cutout is not projected anymore on the skin. It is based on a sketch that inevitably lies on a surface.

This option is available only when creating a standard cutout.

●     In case the profile's edges and the impacted skin to extrude are tangent, the sketch becomes non-valid and 
the cutout cannot be created.

To avoid this, check Lying on skin or select a base feature as support to be able to create your cutout.

 

Open the CutOut1.CATPart document again.

1.  Click the Cutout icon .

2.  Select Sheetmetal pocket as 

Cutout type in the combo box.

The skin to be impacted remains 

grey and the End limit type is 

disabled.

3.  Set the Depth to 1mm.
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4.  Select Sketch.1 as profile.

A preview of the cutout is displayed. 

In our example, the cutout will 

impact only half the base feature.

 

5.  Click OK in the Cutout Definition 

dialog box.

The cutout is created. 

 

4.  In the specification tree, double click on Cut Out.1 to display the Cutout Definition dialog box.

5.  Click More>> to display the maximum information.

The Direction is already selected 

(Sketch.1). By default, it is set as normal 

to the profile.

 



7.  Uncheck Normal to profile.

8.  In the Reference field, right-click on Sketch.1 and select Create line. 

9.  Select the line to perform a cutout normal to the line direction. 

10.  Click on OK to create a cutout normal to the line direction.

 

●     The pocket cutout can be created only on a planar and monosupport surface (i.e. a web a flange or the planar face of a 
surfacic flange).

●     May you want to create a cutout on an overlapping element or a bend with radius=0, either choose the top skin of the 
element (as shown in the picture above), or unfold the part to create the cutout.

●     You cannot create a pocket cutout on a stamp or a surfacic flange.

●     You cannot create 
❍     a standard cutout on a pocket cutout 

❍     a standard cutout on a feature impacting a pocket cutout.

●     You can create
❍     a pocket cutout on a standard cutout.



❍      a pocket cutout on a pocket cutout,

 

Once the Reference Direction and the Objects Support fields are filled in, the selection can be modified but cannot be cleared.

Cutouts can be created directly on the unfolded view of the part.

You can use the Catalog icon  to open the Catalog Browser.

●     Refer to Component Catalog Editor documentation to have further information on how to use catalogs.

●     Refer to the Create a Pocket task in the Part Design User's Guide for further details on how to create cutouts.



Creating a Hole

This task shows you how to create a hole, that consists in removing material from a body.

Open the Hole1.CATPart document.

1.  Click the Hole icon .

The Hole definition dialog box opens.

 

2.  Select the Point that will be the center of the hole.

It can be either a sketch containing one or more points, or a point, or several points.

●     The point can be selected anywhere in the geometry, not necessarily on a surface. In that case, an 
orthogonal projection will be performed.

●     You can also directly click the surface: a point will be created under the pointer. 

●     To deselect a point, click it in the specification tree. 

3.  Select the Support object where the hole will be positioned.

●     The support can be different from the support where the point lies. In that case, an orthogonal 
projection will be performed.
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The hole is previewed with default parameters.

 

4.  Select hole type:

●     Clearance: defined with a center (point) and a radius

●     Index: used to measure and validate parts

●     Manufacturing: used for manufacturing (for example to fasten a part on an equiment

●     Fastener: used as a rivet

Hole types do not affect the hole geometry.

5.  Define the value for the diameter of the hole in the Diameter field.

If you change the Radius value using the spinners, the preview of the hole automatically updates. 
However, if you enter a value directly in the field, you need to click the Apply button to update the 
preview.

6.  Click OK to validate.

The hole (identified as Hole.xxx) is created and the specification tree is updated accordingly.



●     To have further information on Standard Files..., please refer to the Customizing section.

Holes can be created on the flattened part and on the bend in case of a flange.

 



Creating Stamping Features
This section explains and illustrates how to create and use various kinds of stamps.
The table below lists the information you will find.

 
Create a flanged hole: select a point on a face, and set the stamping parameters. 

Create a bead: select a profile, and set the stamping parameters. 

Create a circular stamp: select a point on a face, and set the stamping parameters. 

 
Create a surface stamp: select a sketch, and set the stamping parameters. 

Create a flanged cutout: select a profile, and set the stamping parameters. 

Create a stiffening rib: select the external surface of the bend, and set the stamping parameters.

Create a curve stamp: select a sketch, and set the stamping parameters. 

Create a user-stamp: select a face, and set the stampings parameters.



Creating a Flanged Hole

This task shows you how to create a flanged hole by specifying the punch geometrical parameters.

For the Generative Sheetmetal Design workbench, open the NEWStamping.CATPart document.
For the Aerospace SheetMetal Design workbench, open the Aero_Stamping.CATPart document.

1.  Click the Flanged Hole icon .

2.  Click the surface where you want to place the hole.

A grid  is displayed to help you position the flanged hole.

 

 The Flanged Hole Definition dialog box is displayed, providing default values. 
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Note that the image in the right-hand pane of the dialog box is updated as you choose your parameters and 

options, and provides a graphical explanation about the current selection.

Also note that the options available in the dialog box are updated according to the items selected in the 

Definition Type area.

 

 
3.  Choose the diameter that should be dimensioned from the Parameters choice list:

❍     Major Diameter

❍     Minor Diameter

❍     Two Diameters (major and minor diameters)

❍     Punch & Die

4.  Specify whether the flanged hole should be created without a cone (i.e. only with the filleted portion of the 

flanged hole) or with a cone (i.e. with the filleted portion of the flanged hole and with a cone). 



Note that selecting the Without cone option has the following consequences:

●     The Height H field is disabled, the height being automatically computed in this case.

●     Deactivating the Radius field is impossible, because the radius value for the flanged hole external 

curvature must be specified in this case.

5.  If you want to use a standard, click the Standard File button and browse to select a standard file. In this 

case, the standard parameters will be used, and you do not need to specify the flanged hole parameters. You 

can skip the next step.

6.  Choose the flanged hole parameters:

●     In the Height H field, specify the height value for the flanged hole. Use the icon next to the field to 

specify the reference from which the height is defined:  or .

●     In the Radius R field, specify the radius value for the flanged hole external curvature. Use the icon next 

to the field to disable this option.

●     In the Angle A field, specify the angle value for the flanged hole. 

This option is not available for the Two Diameters or Punch & Die parameters, as the 

angle is automatically computed in these cases.

●     In the Diameter D field, specify the major diameter value for the flanged hole. 

This option is not available for the Minor Diameter parameter, as the major diameter is automatically 

computed in this case.

●     In the Diameter d field, specify the minor diameter value for the flanged hole.

This option is not available for the Major Diameter parameter, as the minor diameter is automatically 

computed in this case.



7.  Click Preview to visualize the flanged hole.

8.  Click OK to validate. 

The flanged hole (identified as Flanged Hole.xxx) is created and the specification tree is 

updated accordingly.

 Flanged hole viewed from the front

 



 Flanged hole viewed from the back

Refer to the Customizing Standard Files chapter for more information about defining the Standards Files.



Creating a Bead

This task shows you how to create a bead, that is a local deformation in the web.

Open the NEWStamping6.CATPart document.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping6.CATPart document.

1.  Click the Bead icon .

2.  Select the spine 

profile where you 

want to place the 

bead.

The Bead 

definition dialog 

box is 

displayed, 

providing 

default values.

3.  Change the value in the different fields, if needed:

●     Height H

●     Radius R

●     Section Radius R1 (corresponding to the cross section value)

●     End Radius R2

The Sketch is automatically set to the sketch you chose.
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The vector for the 
direction of the bead is 
shown in the model and a 
preview of the bead 
appears and a vector 
shows its direction.

4.  Click Preview to visualize the bead.

5.  Click OK to validate.

The bead (identified as Bead.xxx) is created and the specification tree is updated accordingly.

The vector cannot be reverted until the bead spine is defined.

You can use 0 as the Radius value to deactivate the Radius R value, and to create the bead without a 
fillet.

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Circular Stamp

This task shows you how to create a point stamp by specifying the punch geometrical parameters.

Open the NEWStamping.CATPart document from the samples directory.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping.CATPart document.
 
You have now the choice between several parameters to dimension the diameter of your circular stamp.

1.  Click the Circular Stamp icon .

2.  Select a point on the top face. 

A grid is displayed to help you position the circular 
stamp.

The Circular Stamp Definition dialog box opens, providing default values.

3.  Choose the diameter that should be dimensioned from 

the Parameters choice list:

❍     Major Diameter

❍     Minor Diameter

❍     Two Diameters (major and minor diameters)

❍     Punch & Die

4.  Change the value in the different fields, if needed:

●     Height H: use the icon next to the field to 

specify the reference from which the height is 

defined:  or .

●     Radius R1

●     Radius R2

●     Angle A

●     Diameter D
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4.  Click Preview to visualize the circular stamp.

 
5.  Click OK to validate.

The circular stamp (identified as Circular Stamp.xxx) is created and the specification tree is updated accordingly.

 

To create the point stamp without a fillet, unselect the Radius 
R1 and Radius R2 checkbox in the Circular Stamp Definition 
dialog box.

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Surface Stamp

This task shows you how to create a surface stamp by specifying the punch geometrical parameters.

Open the NEWStamping4.CATPart document from the samples directory.

If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping4.CATPart document.

Stamps can be based on different types of profile:
●     a profile containing a sketch with several inner contours

●     a profile containing a 3D curve sketch

●     a profile containing a punch and die sketch intersecting with the part

You can now apply parameters, such as height, radius, angle etc. on the top or on the bottom of the surface stamp: 

●     When selecting , parameters are applied to the top of the surface stamp 

●     When selecting , parameters are applied to the bottom of the surface stamp

You can now create Half pierce stamps. For more information, refer to the Creating a Half Pierce Stamp section.

1.  Click the Surface Stamp icon .

2.  In the specification tree, select Sketch-for-Surface-Stamp, the profile previously defined. 

The Surface Stamp Definition dialog box opens, providing default values. 

3.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Height H: 4mm

●     Radius R1: 2mm

●     Radius R2: 2mm

●     Angle A: 90deg
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4.  Click in the Opening Edges field and select a 

sketch's edge.

 

5.  Click Preview to visualize the surface stamp with 

an opening edge.

6.  Click OK to validate.

The surface stamp (identified as Surface Stamp.1) is created and the specification tree is updated accordingly.

 

You can disable Radius R1 and Radius R2 if you want to 
create the surface stamp without a fillet.

Now let's create a stamp of type 1 based on a profile containing several inner contours: one stamp in a direction and other stamps in 
opposite direction.

1.  Click the Surface Stamp icon .

 



2.  In the specification tree, select Sketch-multicontour-type1

The Surface Stamp Definition dialog box opens.

3.  Select Angle as Definition type and the first type of stamp 

 

4.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Height H: 10mm

●     Radius R1: 1mm

●     Radius R2: 1mm

●     Angle A: 90deg

5.  Click Preview to visualize the surface stamp.

 

6.  Click OK to validate.

The surface stamp with several inner contour (identified as Surface Stamp.2) is created and the specification tree is updated 

accordingly.

Now, let's create another stamp based on a profile containing several inner contours of type 2.

1.  Click the Surface Stamp icon .

2.  In the specification tree, select Sketch-multicontour-type2

The Surface Stamp Definition dialog box opens. 

3.  Select Angle as Definition type and the second type of stamp 



4.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Height H: 13mm

●     Radius R1: disabled

●     Radius R2: disabled

●     Angle A: 60deg

5.  Click Preview to visualize the surface stamp.

6.  Click OK to validate.

The surface stamp with several inner contour (identified as Surface Stamp.3) is created and the specification tree is updated 

accordingly.

 

Now, let's create a stamp based on a profile containing 2 contours (one inside the other)

1.  Click the Surface Stamp icon .

 

2.  In the specification tree, select Sketch-punch&die

The Surface Stamp Definition dialog box opens. 

 

3.  Select Punch and Die as Definition type.

When Punch and Die is selected, only the second type of stamp is enabled 



4.  Change the value in the different fields, if needed.

In our example, we chose the following values:

●     Height H: 13mm

●     Radius R1: disabled

●     Radius R2: disabled

●     Angle A: disabled

5.  Click Preview to visualize the surface stamp.

 

6.  Click OK to validate.

The surface stamp with two contours (identified as Surface Stamp.4) is created and the specification tree is updated accordingly.

Each punch edge must be parallel to the corresponding 
die edge.

Now, let's create a stamp based on a profile containing a 3D curve.

To do this, open the XXX.CATPart document from the samples directory.
If you use the Aerospace SheetMetal Design workbench, open the XXX.CATPart document.

1.  Click the Surface Stamp icon .

 



2.  In the specification tree, select Folded curve.1.

The Surface Stamp Definition dialog box opens. 

Make sure that Angle is selected as parameter, as well as the first type of stamp.

 

3.  Change the value in the different fields, if needed:

●     Height H:20mm

●     Radius R1: 2mm

●     Radius R2: 2mm

●     Angle A: 90deg

4.  Click Preview to visualize the surface stamp.

 

5.  Click OK to validate.

The surface stamp with a 3D curve profile (identified as Surface Stamp.xxx) is created and the specification tree is updated 

accordingly.

You can also create a stamp based on a 3D multicurve 
profile.

For instance, you can create a surface stamp based on 
the Folded curve.5 and obtain the following result:

Avoid as much as possible a coincidence between the edge of the sketch profile and the edge of the wall. Instead, let the sketch profile 
exceed the edge of the wall.

Insert a screen capture

 



Creating a Flanged Cutout

This task shows you how to create a flanged cutout by specifying the punch geometrical parameters.

Open the NEWStamping8.CATPart document.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping8.CATPart document.

1.  Click the Flanged Cutout icon . 

2.  Select a profile. 

The Flanged Cutout Definition dialog box is displayed, providing default values.
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3.  Change the value in the different fields, if needed:

●     Height H

●     Radius R

●     Angle A

 
4.  Click Preview to visualize the flanged cutout. 

 

 
5.  Click OK to validate. 

The flanged cutout (identified as Flanged Cutout.xxx) is created and the specification tree is updated 

accordingly.

 



 

You can use 0 as the Radius value to deactivate the Radius R value, and to create the flanged cutout 
without a fillet.

 

 Note that if you create a flanged cutout from a sketch that is not tangent continuous, you cannot 
design any other feature on it (such as bend, cutout, hole).

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Stiffening Rib

This task shows you how to create a stiffness rib by specifying the punch geometrical parameters.

Open the NEWStamping7.CATPart document from the samples directory.

 If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping7.CATPart document.

1.  Click the Stiffening Rib icon .

2.  Select the external surface of Bend.1, where you want to place a stiffener.

Note that the stiffener will always be centered on the bend radius, wherever the point may be along the curve.

A grid is displayed.

The Stiffening Rib Definition dialog box opens, providing default  values.

3.  Change the value in the different fields, if 

needed:

●     Length L

●     Radius R1

●     Radius R2

●     Angle A

4.  Click Preview to visualize the stiffness rib.

5.  Click OK to validate.

The stiffening rib (identified as Stiffnening Rib.xxx) is created and the specification tree is updated accordingly.
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You can use 0 as the Radius value to deactivate the 
Radius R1 value, and to create the stiffening rib 
without a fillet.

Please refer to the Customizing Standard Files chapter to define the Standards Files.



Creating a Curve Stamp

This task shows you how to create a curve stamp by specifying the punch geometrical parameters.

Open the NEWStamping3.CATPart document.
If you use the Aerospace SheetMetal Design workbench, open the Aero_Stamping3.CATPart document.

1.  Click the Curve Stamp icon .

2.  Select Sketch-for-Curve-Stamp, the curve previously defined. 

The Curve Stamp Definition dialog box opens, providing default values.

3.  Change the value in the different 

fields, if needed:

●     Height H: the total height

●     Radius R1: the outer bend 

radius

●     Radius R2: the inner bend 

radius

●     Angle A: the stamping draft 

angle 

●     Length L: the stamps' 

maximum width

4.  Click Preview to visualize the 

curve stamp.

5.  Click OK to validate.

The curve stamp (identified as Curve Stamp.xxx) is created and the specification tree is updated accordingly.
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●     You can use 0 as the Radius value to 
deactivate the Radius R and Radius R2 
values, and to create the curve stamp 
without a fillet.

●     Check the Obround option to round off the edges of the curve stamp.

 

Obround option checked Obround option unchecked

Please refer to the Customizing Standard Files chapter to define the Standards Files.

 



Creating User-Defined Stamping Features
Two user-defined stamping features are available: 

 Create a punch with die:  define the punch and die features, select a base feature, choose the punch and die as stamping 
elements, select an edge on the base surface and give an angle for orientation purposes.

 Create a punch with opening faces: define the punch, select a base feature, define the opening faces of the punch, select 
an edge on the base feature and give an angle for orientation purposes.

 Edit a user-defined stamp: double-click the existing stamp and change its type, or select, or remove opening faces

What You Should Know 

In both tasks illustrating either a stamp based on a punch with die, or a punch with opening faces, the punch positioning is 
defined as below: 

Defining the Punch in Relation to the base feature to be Stamped

The punch is defined within the absolute (default) axis-
system of the .CATPart document. (o, x, y, z) is the 
axis associated with the punch. The punching direction 
on the punch (Dp) must be equal to z.

The punching direction on the base feature (Dw) is 
normal to the selected base feature face, and is 
oriented from the selected base feature face towards 
the opposite face.

The punch is applied matching Dp on Dw and matching the punch's (x, y) plane onto the selected base feature face:



Defining the Die in Relation to the base feature to be Stamped

This is useful only when defining a punch with die, and does not apply to punches with opening faces.

The die is also defined within the absolute (default) axis-
system of the .CATPart document. (o, x, y, z) is the 
axis associated with the punch. The punching direction 
on the die (Dd) must be equal to z. 

The illustration is a section view of the die.

The die is applied matching Dd on Dw and matching the die's (x, y) plane onto the selected face:

 



Creating a Punch with a Die
This task explains how to create a stamp from punch and die features. 

First, you will define a punch and a die in Part Design, in the absolute axis-system.
Then, in a Sheet Metal part, you will bring the punch and the die features (and their axis system) to a point you have selected. If necessary, you will 
define a rotation of the axis system from a reference line.

You can also position the stamp according to the punch and die features positioning and direction thanks to the On context option. 

This user-defined stamping cannot be combined with the Opening and Cutting Faces approach.

All .CATParts are available from the samples directory (PunchDie1.CATPart, Punch1.CATPart and Die1.CATPart or NEWPunchDie1.CATPart, 
NEWPunch1.CATPart and NEWDie1.CATPart for Generative Sheetmetal Design or Aero_PunchDie1.CATPart, Aero_Punch1.CATPart and 
Aero_Die1.CATPart for Aerospace Sheetmetal Design).

1.  Start the Part Design application.

2.  Insert a PartBody (menu Insert -> Body) to define the punch.

3.  Enter the sketcher  select the yz plane, 

and draw the profile of the punch, and a 

rotation shaft.

 

The punch must be oriented as described 
in Defining the Punch in Relation to the 
base feature to be Stamped.

4.  Return to the 3D space and create the punch 

using the Shaft icon .

5.  Repeat from step 2 to step 4 to define the die, making sure that it is oriented as described in Defining the Die in Relation to the base feature 

to be Stamped.
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6.  Return to the Sheet Metal application, and if needed, use the Define In Work Object on the PartBody containing the wall or the base feature 

to be stamped.

7.  Click the User Stamping icon  from the Stamping tool bar and select a base feature, or a face where the stamping is to be created. 

This base feature or face is used to define the stamping location and direction, by matching the punch's origin to the selected point on the 

base feature.

The User Defined Stamp Definition dialog box is displayed:

8.  Make sure the With die  icon is pressed 

down and select the Punch feature from the 

specification tree.

The punch's positioning is previewed in the 

geometry.

9.  Select the Die feature. 

The die's positioning is previewed in the 

geometry as well.



10.  Check the No Fillet button is you do not wish the stamp to be filleted, or set the radius value if you wish the stamp to be filleted. 

Stamp without fillet Stamp with fillet

11.  If needed, define the stamp's positioning on the selected base feature by choosing:

●     a Reference for rotation: by default, it is the sketch axis, but you can also select any line or edge on base feature.

●     a Rotation angle value: you can either enter a value in the dialog box, or use the manipulator in the geometry to define this value.

●     a new Origin point on the base feature to coincide with the punch's point of origin.

This is especially useful for non-circular stamps, but you can very well create the stamp as is, without further positioning.

12.  If needed, select the In Context check box.

The punch and die's positioning is previewed on the geometry.

 

When selecting the On Context check box, the stamp's positioning and direction are not defined in relation to the base feature anymore.

Only the punch and die's axis system is taken into account and the stamp is created according to their positioning and direction. 
Once On Context is selected, the position on wall cannot be modified nor the direction of the stamp: the fields available in Position on wall section 
and the Reverse direction button are disabled.

13.  Click OK to validate and create the stamping.

By default the Punch and Die parts are set in No Show mode when clicking OK to create the stamp on the base feature. 



●     Radius is the radius of the bend between the stamping and the base feature.

●     Punch and Die are the bodies you have defined previously. If the punch and the die are in another CATPart document, activate this document 
before clicking the punch or the die.

●     If you select two reference lines in addition to the plane, this will create two editable constraints to position the stamping. These constraints are 
editable.

 
●     A user-defined stamping can be edited (punch, die, position, constraints).

●     As the punch and die are not symmetrical, you cannot create such features as a cutout, a hole, a corner, etc., on this kind of stamping.

●     If you enter a punch and a die, the stamping is 
the difference of the shape of both features.

 

●     The punch height cannot be superior to the base 
feature height, otherwise it is considered as a 
cutout.



●     You may create a user-defined stamping from a 
punch only but you cannot create a fillet.  

 

●     Only the stamping sketch is displayed in unfolded 
views.

 

●     The punch and die bodies can be defined in the 
Sheet Metal part where the stamping is to be 
created (see PunchDie1.CATPart or 
NEWPunchDie1.CATPart in the samples 
directory).

In this case, make sure you select the 
Define In Work Object on the PartBody 
containing the base feature to be stamped, 
prior to actually creating the stamp.

or as two separate Part Design parts (Punch1.CATPart and Die1.CATPart from the samples directory)

 

In this case, when selecting the punch or die feature, the system automatically copies this feature into the .CATPart document into which the base 
feature to be stamped is located.
A link is retained between the initial punch or die feature and its copy.
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Creating a Punch with Opening Faces

This task explains how to create a stamp from a punch feature with opening faces. 

First, you will define a punch in Part Design, in the absolute axis system.
Then, in a Sheet Metal part, you will bring the punch feature (and its axis system) to a point you have 
selected. If necessary, you will define a rotation of the axis system from a reference line.

You can also position the stamp according to the punch and die features positioning and direction thanks 
to the On context option. 

This user-defined stamping cannot be combined with the Punch with a Die approach.

The CATPart documents are available from the samples directory, NEWOpenFaces1.CATPart for is 
Generative Sheetmetal Design or Aero_OpenFaces1.CATPart for Aerospace Sheetmetal Design.

1.  Start the Part Design application.

2.  Insert a PartBody (menu Insert -> Body) to define the punch.

3.  Enter the Sketcher workbench , select the yz plane, and draw the profile of the punch.

4.  Return to the 3D space and create the punch using the pad icon  and the fillet icon .

 

The punch must be oriented as described in Defining the Punch in Relation to the base feature to be 
Stamped.

●     The punch can be defined in the Sheet Metal part where the stamping is to be created or in another 
part.
In this case, when selecting the punch feature, the system automatically copies it into the .CATPart 
document into which the base feature to be stamped is located.
A link is retained between the initial punch feature and its copy.
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5.  Return to the Sheet Metal application, and if needed, use the Define In Work Object on the 

PartBody containing the base feature to be stamped.

6.  Click the User Stamp icon  from the Stamping toolbar and select a base feature where the 

stamping is to be created. 

This base feature is used to define the stamping location and direction, by matching the 

punch's origin to the selected point on the base feature.

The User Defined Stamp Definition dialog box is displayed.

7.  Click the With opening  icon.

8.  Select the punch (Body.2). The punch is previewed on the base feature.



 

 
9.  Click the Faces for opening field and select the lateral faces of the punch (Pad.1).

 

 
10.  Click Preview. The stamp is previewed with the opening faces:

10.  Select the On Context check box if you wish to position the stamp according to the positioning 

and direction of the punch and die features.

11.  Click Preview. The stamp is previewed with the opening faces at the point where the punch and 

die were created on the part:



 

For more information about the On context check box, refer to the Creating a Punch with a Die section.

12.  Check No Fillet is you do not wish the stamp to be filleted, or set the radius value if you wish the 

stamp to be filleted. 

13.  If needed, define the stamp's positioning on the selected base feature by choosing:

●     a Reference for rotation: by default, it is the sketch axis, but you can also select any 

line or edge on the base feature.

●     a Rotation angle value: you can either enter a value in the dialog box, or use the 

manipulator in the geometry to define this value.

●     a new Origin point on the base feature to coincide with the punch's point of origin.



This is especially useful for non-circular stamps, but you can very well create the stamp as is, 
without further positioning.

14.  Click OK to validate and create the stamping. 

The stamp is automatically set in No Show mode. 



●     Radius is the radius of the bend between the stamping and the base feature.

●     Punch is the body you have defined previously. If the punch is in another .CATPart document, 
activate this document before clicking the punch.

●     The Faces for opening must be picked on the punch, not on the base feature. 
If the punch is located into another .CATPart document, these faces must be picked on the copy of 
the punch where the base feature to be stamped is located.

●     If you modify the selected punch, the user-defined stamp with the opening faces will not be updated 
accordingly, nor will it be updateable. If you want to update the user-defined stamp, you will need to 
edit it; in the User Defined Stamp Definition dialog box, clear the Faces for opening field and re-
select the lateral faces of the modified punch.

●     Avoid using stamps with faces merging with the face of the base feature to be stamped, as it would 
be difficult to remove afterwards, especially on a curved part.
If you do use such a stamp, select the stamp face tangent to the base feature and define it as an 
open face.

●     If you select two reference lines in addition to the plane, this will create two editable constraints to 
position the stamping. These constraints are editable.

 
●     A user-defined stamping can be edited (punch, die, position, constraints).

●     Check the No fillet option to deactivate the Radius R1 value, and to create the stamp without a fillet.



Editing User-Defined Stamps

This task explains how to edit a user-defined stamp, that is: 

●     to change its type

●     add or remove cutting and opening faces 

To perform this scenario, you can open any .CATPart document containing a user-defined stamp.

1.  Double-click the existing user-defined stamp from the specification tree.

The User Defined Stamp Definition dialog box is displayed. 



2.  Change stamp type using the icons:

●     If you change from With die to With opening, the Die feature no longer is selected, and you need 

to select Faces for opening.

●     If you change from With opening to With die, the punch faces no longer are selected and you may 

select a die feature if you wish (it is not compulsory).

Basically, only the punch remains selected.
If you are working with a punch with opening faces (With opening option) you may want to add or 
remove some opening faces:

3.  Click in the Faces for opening field then:

●     select a face in the geometry to add it to the already selected opening faces

●     select an already selected face to remove it from the opening faces

●     use the Clear selection contextual menu to remove all opening faces that have been previously 

selected. 

4.  Modify any other parameter as needed.

5.  Click OK in the User Defined Stamp Definition dialog box to take these modifications into 

account.

The stamp is updated accordingly.

 



Creating a Local Corner Relief

This task explains how to define a corner relief locally on a set of supports.

Open the CornerRelief01.CATPart document from the samples directory.
The part needs to be unfolded prior to creating the corner relief.

1.  Click the Corner Relief icon .

The Corner Relief Definition dialog 

box  is displayed. 

2.  Select the supports on which a 

corner relief should be created (here 

we chose Surfacic Flange.1 and 

Surfacic Flange.2)

A notch was defined on the web profile between the two fillets' flanges; so that flanges do not intersect. This 
operation enables to prepare the web as to create the flanges that will be later used to define the corner relief.

●     By default the User Profile  is active in the Corner Relief Definition dialog box.
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1.  Select the sketch, directly 

in the 3D geometry.

 

 As soon as the sketch has been selected, 

the Sketcher  icon is displayed in the 

dialog box allowing you to edit the selected 
sketch, if needed. 

The red arrow lets you choose the direction 
of matter to remove. Click it to reverse the 
direction.

2.  Click OK in the Corner 

Relief Definition dialog 

box.

 You can use the Catalog icon  to open the Catalog Browser.

For more information on catalogs, please refer to the Using Catalogs chapter in the CATIA Infrastructure User Guide.

●     Select the Circular Profile  

using the down arrow. 



1.  Define the default radius: it is equal to the bend radius + the thickness.

In our example, we defined a radius of 15 mm.

By default the corner relief center is located at the intersection of the bend axes. You can select a point as 
the circle's center. 

2.  Select the vertex between 
the two flanges: it will be 
the center of the corner 
relief.

3.  Click OK in the Corner 

Relief Definition dialog 

box.

 

The created element (identified as Corner Relief.xxx) is added to the specification tree.

3.  Fold the part to check the corner relief in 3D.



Folded user corner relief Folded circular corner relief

The Supports Redefinition checkbox 

enables to redefine the supports' sides thus 

adding matter to these supports.

In that case, the created element (identified 

as Corner Relief.xxx) appears before the 

supports in the specification tree.

●     Please note that checking this button means that the corner relief replaces the surfacic flange's side. This side 

must therefore exists: when creating the surfacic flange, do not define the side as None.

●     In hybrid context, when checking Supports Redefinition, the Surfacic flanges are hidden in the 3D since the 

define in work object parameter is applied to the corner relief.

●     Moreover, the sketch is not aggregated anymore under the corner relief in the specification tree. 



Yet, if you open a part created in a previous release, the specification tree will be displayed accordingly to 

the previous behavior.

Fore more information about Hybrid Design, refer to the Hybrid Design section.

Unfolded user corner relief
with redefined supports

Folded user corner relief
with redefined supports 
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The image besides shows two surfacic 
flanges creating with Angle as support type.
The two blue dotted lines represent the 
limits of the unfolded surfacic flanges.

 

●     The creation of a corner relief with supports redefined is not possible as it is not located within the limits of the 
unfolded flanges.

●     A corner relief with supports redefined cannot be created if its profile implies adding matter to the web.

 

 



Creating Constraints

This task shows how to set geometric constraints on geometric elements. 

Such a constraint  forces a limitation. For example, a geometric constraint might require that two lines 
be parallel.

To set a constraint  between elements:

1.  Multi-select two or three elements to be constrained.

2.  Click the Constraint defined in dialog box icon 
.

The Constraint Definition dialog box appears indicating the types of constraint you can set between the 
selected elements.

 
 

 
3.  Select one of the available options to specify that the corresponding constraint should be made.

4.  Click OK.

The corresponding constraint  symbol appears on the geometry.



 To set a constraint on a single element:

1.  Select the element to be constrained.

2.  Click the Constraint icon .

The corresponding constraint  symbol appears on the geometry.

 



Mapping Elements

 

This task shows how to create curves or points from a sketch (as designed using the Sketcher) or from 
existing curves or points,  onto a Sheet Metal part; and to fold/unfold it, just as other Sheet Metal 
elements. 
This is especially useful when: 

●     you want to generate a logotype

●     you want to define an area for chemical milling

●     you want to create a cutout (pocket) to solve the overlapping of walls for example (the overlapping 
can be checked with the Sheet Metal Production product).

 

If you use SheetMetal Design, open the Mapping1.CATPart document.
If you use Generative Sheetmetal Design, open the NEWMapping1.CATPart document.
If you use Aerospace SheetMetal Design, open the Aero_Mapping.CATPart document.

These samples already contain a pre-defined sketch that will be mapped onto the part. 

Otherwise, you would need to defined a sketch by entering the Sketcher workbench , selecting the 

wall onto which the curve should lie, and drawing the sketch you wish.
 

1.  Make sure the sketch is selected, and click the Point or Curve Mapping icon  .

The Elements To Map definition dialog box is displayed, indicating which elements have been 
selected for mapping.
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 You can manage the list of elements:

●     to remove an element, select it from the list and use the Clear selection contextual menu

●     to add an element,  select it directly in the geometry.
Order in the list does not matter. 

2.  Select the Mapping Context, that is the element of the part on which the curve should be 

generated when folding or unfolding.

The Mapping Context is not necessarily the support element on which the element to be mapped has 
been drawn. Indeed, by default, the Mapping Context is the last Sheet Metal feature that has been 
created or modified, that is the current feature in the specification tree.

3.  Click OK. The curve mapping is created and added in the specification tree.

 
 

Folded view of the curve mapping Unfolded view of the curve mapping



●     You can select several sketches/curves/points to be mapped at a time.

●     Mapped curves can be created across several walls and bends.

 

 



Creating Corners

This task shows how to create one or more corner(s) on a Sheet Metal part, that is to round off sharp edges, much like a fillet between two 
faces of a Part Design body.
This corner creation operation can be performed indifferently on the folded or unfolded view, and only one support (i.e. the corner when 
previewed should not lie over two supports).

 

Open the Corner1.CATPart document.
If you use Aerospace SheetMetal Design, open the Corner_Aero1.CATPart document.

1.  Click the Corner icon . The Corner dialog box is displayed. 

 

 
2.  Set the radius value.

3.  Choose the type of edge you wish to round off: Convex Edge(s) and/or Concave Edge(s). For the purpose of this scenario, leave 

both options selected.

Once you have selected an edge, you can no longer modify the chosen options (they are grayed out), unless you cancel the selection.
 

4.  Click to select a convex edge on a part.

As soon as you selected one edge, the dialog box is updated and the Select All button changes to Cancel Selection.

 

The corner is previewed on the edge, with the current radius value.

 
5.  Click to select a concave edge on a part.
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 The corner is previewed on the edge, with the current radius value.
 

6.  Click Cancel Selection then click the Select All button. All edges of the part are selected and the corners previewed.

7.  Click OK in the dialog box.

All sharp edges of the part are rounded off to create smooth corners.



    

To deselect an edge, simply click it again. For quick selection in a complex part, you can select all edges with the Select All check button, 
then deselect one or two edges.

    
●     When you select an edge that is not sharp, such as the edge between a wall and a bend for example, a warning is issued.

●     As you select more edges, the Edge(s) field of the dialog box is updated.

●     When using the Select All button, you select all edges present at the time. If when modifying the part, new edges are created, these will 
not be automatically rounded off.

 

 



Creating Chamfers

This task shows how to create one or more chamfer(s)  on a Sheet Metal part, that is to cut off, or fill in 
sharp edges of Sheet Metal parts.
This chamfer creation operation can be performed indifferently on the folded or unfolded view, and only 
one support (i.e. the chamfer when previewed should not lie over two supports).

 

Open the Corner1.CATPart document.
If you use Aerospace SheetMetal Design, open the Corner_Aero1.CATPart document.

1.  Click the Chamfer icon .

The Chamfer Definition dialog box is 

displayed. 

You can choose the type of edge you wish to chamfer: 
●     using the Select All button, you can select all convex edges on the part

●     any edge you select manually.

 
2.  Leave the Convex Edge(s) option selected.

3.  Select a sharp edge on a part. 

 
If you want to create a longitudinal chamfer, you can select a single long edge. This allows you 

to create a welding chamfer, for example.

The chamfer is previewed on the edge.

Remember that when you create a chamfer on one edge it is automatically propagated on the tangent 
edge.

As soon as you selected one edge, the dialog box is updated and the Select All button changes to 

Cancel Selection.
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3.  Choose a chamfer mode. You can either enter:

●     two lengths: these lengths are computed 
from the selected edge on both sides.
Here, we chose two lengths of 10mm.

   

●     a length value and an angle: the length is 
computed on one side of the edge and the 
angle from the chamfer's limit on the same 
side.
Here, we chose a length of 10mm and an 
angle of 60deg.

You can use the Reverse button to inverse all edges' side, on which the values are taken into account.

4.  Click Cancel Selection then click the Select All button.

All sharp edges of the part are selected, the Select All button taking into account the chosen 

type and the chamfers previewed.



5.  Click OK in the dialog box.

All sharp edges of the part are cut off or filled in. 



     

To deselect an edge, simply click it again. For quick selection in a complex part, you can select all edges 
with the Select All button, then deselect one or two edges.

     
●     When you select an edge that is not sharp, such as the edge between a wall and a bend for example, 

a warning is issued.

●     As you select more edges, the Edge(s) field of the dialog box is updated.

●     When using the Select All button, you select all edges present at the time. If when modifying the 
part, new edges are created, these will not be automatically chamfered.

●     When the sharp edge is selected in the thickness of the wall, its length has to be equivalent to the 
wall's thickness.

●     If the sharp edge is not selected in the thickness of the wall, it has to limit the faces of the wall. 

 



Patterning
This section explains and illustrates how to create various kinds of patterns on Aerospace Sheet Metal parts.

Create rectangular patterns: select the element to be duplicated, set the patterning type, and its 
parameters, and the reference direction

Create circular patterns: select the element to be duplicated, set the axial reference  parameters, the 
reference direction, and possibly the crown definition

Create user-defined patterns: select the element to be duplicated, and the positioning sketch and 
anchor point 

    

To have further information about patterns, refer to Part Design User's Guide.



Creating Rectangular Patterns

In this task, you are going to create rectangular cutouts according to a pattern.
These features make the creation process easier.

You can only duplicate the following items: 
●     cutouts

●     holes

●     beads

●     flanges

●     flanged holes

●     stamps (except stiffening ribs)

●     Aerospace Sheetmetal Design patterns

These features must lie on a unique and planar surface.

 

Open the RectangularPattern1.CATPart document.

1.  Select the rectangular cutout you want to duplicate.

 
 

2.  Click the Rectangular Pattern icon .
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The Rectangular Pattern Definition dialog box is displayed. Each tab is dedicated to a 
direction to define the location of the duplicated feature. 

3.  Set the specification for the First Direction by selecting the first edge (Edge.2) as shown, to 

specify the first direction of creation.

An arrow is displayed on the flange. 

The Reverse button enables to modify the direction.

You can also click the arrow in the 3D geometry.

4.  Keep the Instances & Spacing options to define the parameters.

Choosing these parameters types dims the Length field because the application no longer needs 

this specification to space the instances.

 



You can set the duplication parameters by choosing the number of instances, the spacing between 
instances, or the total length of the zone filled with instances.
Three options are available: 

●     Instances & Length: the spacing between instances is automatically computed based on 

the number of instances and the specified total length

●     Instances & Spacing: the total length is automatically computed based on the number of 

instances and the specified spacing value

●     Spacing & Length: the number of instances is automatically computed to fit the other 

two parameters.

For each of these cases only two fields are active, allowing you to define the correct value.

If you set Instances & Length or Spacing & Length parameters, note that you cannot 

define the length by using formulas.

Patterns should not go beyond the surface (this can be checked using the preview).

5.  Enter 2 as the number of instances you wish to obtain in the first direction.

6.  Define the spacing along the grid: enter 30mm.

Defining the spacing along the grid and the length of your choice, would make the application compute 
the number of possible instances and space them at equal distances.

 
7.  Now, click the Second Direction tab to define the other parameters.

Note that defining a second direction is not compulsory. Creating a rectangular pattern defining only one 
direction is possible.

 
8.  Select the second edge (Edge.3), as shown, to define the second direction.

 
9.  Keep the Instances & Spacing option: enter 8 and 10 mm in the appropriate fields.

Additional cutouts have been aligned along this second direction.



 

10.  Click OK to repeat the cutouts.

 After the update, the part looks like this:  



11.  Select this icon  to unfold the part:

The pattern is updated on the unfolded view.

 
12.  Click the More>> button to display further options.

 

The Simplified representation option lets you lighten the pattern geometry, when more than 10 
instances are generated in one direction. What you need to do is just check the option, and click Preview. 
The system automatically simplifies the geometry:

 You can also specify the instances you do not want to see by double-clicking the dots. These instances 
are then represented in dashed lines during the pattern definition and then are no longer visible after 
validating the pattern creation. The specifications remain unchanged, whatever the number of instances 
you view. This option is particularly useful for patterns including a large number of instances.



●     When you duplicate a pattern of flange, the edge of the flange spine and its instances have to be 
tangent to the wall edge: you cannot choose a direction of patterning not parallel to the flange spine.

●     All instances of the flange pattern must lie on the same face as the flange pattern.



Creating Circular Patterns

In this task, you are going to create circular cutouts according to a pattern.
These features make the creation process easier.

You can only duplicate the following items: 
●     cutouts

●     holes

●     beads

●     flanges

●     flanged holes

●     stamps (except stiffening ribs)

●     Aerospace Sheetmetal Design patterns

These features must lie on a unique and planar surface.

 

Open the CircularPatterns1.CATPart document.

1.  Select the circular cutout you want to duplicate.

  

2.  Click the Circular Pattern icon .

The Circular Pattern Definition dialog box is displayed.

3.  Define the Axial Reference by choosing the Parameters type, and reference direction.
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●     Instance(s) & total angle: the number of patterns as specified in the instances field are created, in the specified 

direction, and evenly spread out over the total angle.

 

●     Instance(s) & angular spacing: the number of patterns as specified in the instances field are created in the specified 

direction, each separated from the previous/next one of the angular angle value.



 

 
●     Angular spacing & total angle: as many patterns as possible are created over the total angle, each separated from 

the previous/next one of the angular angle value.

 
●     Complete crown: the number of patterns as specified in the instances field are created over the complete circle 

(360deg). 



 

 

If you set Instance(s) & total angle or Angular spacing & total angle parameters, note that you cannot define the 
length by using formulas.

4.  Click the Reference element and select the element defining the rotation axis.

Here select the face on which lies the circular cutout.

●     To define a direction, you can select an edge or a planar face.
Should you select the face of a web, the rotation axis would be normal to that face.

●     Click the Reverse button to inverse the rotation direction.

Now you are going to add a crown to this pattern.

5.   Click the Crown Definition tab, and choose which parameters you wish to define the crown.

This figure may help you define these parameters:

 



 
●     Circle(s) and crown thickness: you define the number of circles and they are spaced out evenly over the specified crown 

thickness

●     Circle(s) and circle spacing: you define the number of circles and the distance between each circle, the crown thickness 
being computed automatically

●     Circle(s) spacing and crown thickness: you define the distance between each circle and the crown thickness, and the 
number of circles is automatically computed.

 For example, using the values described above for the Angular spacing & total angle option, you could define 
the crown as: 

Note that one of the pattern goes beyond the flange (this can be checked using the preview).

You can delete instances of your choice when creating or editing a pattern. To do so, just select the points materializing 
instances in the pattern preview.

The instance is deleted, but the point remains, as you may wish to click it again to add the instance to the pattern definition 
again.

 

 
6.  Click the More>> button to display further options:



 

 
Using these options, you can change the position of the selected cutout within the crown. For example, if you set the Row 

in angular direction parameter to 4, this is what you obtain: the initially selected cutout is the fourth instance, based on 

the rotation direction, of the pattern.

Typically, in this case, you might want to edit the pattern and click again the instance that you removed above, to get a full 

pattern.

●     The Simplified representation option lets you lighten the pattern geometry, when more than 10 instances are 
generated in one direction. What you need to do is just check the option, and click Preview. The system automatically 
simplifies the geometry:
You can also specify the instances you do not want to see by double-clicking them . These instances are then 
represented in dashed lines during the pattern definition and then are no longer visible after validating the pattern 
creation. The specifications remain unchanged, whatever the number of instances you view. This option is particularly 
useful for patterns including a large number of instances.

●     When checking the Radial alignment of instances, all instances have the same orientation as the original feature. 
When unchecked, all instances are normal to the lines tangent to the circle.

7.  Click OK to create the pattern.

●     When you duplicate a pattern of flange, the edge of the flange spine and its instances have to be tangent to the wall 
edge: you cannot choose a direction of patterning not parallel to the flange spine.

●     All instances of the flange pattern must lie on the same face as the flange pattern.



Creating User-Defined Patterns

The User Pattern command lets you duplicate a cutout, a stamp, or any other feature as many times as 
you wish at the locations of your choice.
Locating instances consists in specifying anchor points. These points are sketches.
You can only duplicate the following items: 

●     cutouts

●     holes

●     beads

●     flanges

●     flanged holes

●     stamps (except stiffening ribs)

●     Aerospace Sheetmetal Design patterns

These features must lie on a unique and planar surface.

 

Open the UserPatterns1.CATPart document.

1.  Select the feature to be duplicated.

Here we selected the cutout. 

2.  Click the User Pattern icon .

The User Pattern Definition dialog box is displayed.
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3.  Select 'Sketch 3' in the specification tree and click Preview.

The sketch contains the points you need to locate the duplicated cutouts. 

 

By default, the application positions each instance with respect to the center of gravity of the element to 
be duplicated. To change this position, use the anchor field: click the anchor field and select a  vertex or 
a point.

4.  Click inside the Anchor field and select the point (Point.1) to indicate a new reference location.

 

 
5.  You can then click the points corresponding to the pattern instances to be removed.

Patterns should not go beyond the surface (this can be checked using the preview).



 

6.  Click OK in the User Pattern Definition dialog box.

Cutouts are created at the points of the sketch.

 

Would you need to unfold the part using the  icon, you would notice that the pattern is updated.

●     When you duplicate a pattern of flange, the edge of the flange spine and its instances have to be 
tangent to the wall edge: you cannot choose a direction of patterning not parallel to the flange spine.

●     All instances of the flange pattern must lie on the same face as the flange pattern.



Reference Elements
You can create wireframe elements within the Aerospace Sheetmetal Design workbench:

Create points: click this icon, choose the point creation type, and specify parameters

Create lines: click this icon, choose the line creation type, and specify parameters

Create planes: click this icon, choose the plane creation type, and specify parameters

 



Creating Points

 

This task shows the various methods for creating points: 
●     by coordinates

●     on a curve

●     on a plane

●     on a surface

●     at a circle/sphere center

●     tangent point on a curve

●     between

 
Open the Points3D1.CATPart document.

 
1.  Click the Point icon  .

The Point Definition dialog box appears.

2.  Use the combo to choose the desired point type.

Coordinates 
●     Enter the X, Y, Z 

coordinates in the current 
axis-system.

●     Optionally, select a 
reference point.

The corresponding 
point is displayed.

 

 

When creating a point within a user-defined axis-system, note that the Coordinates in absolute axis-
system check button is added to the dialog box, allowing you to be define, or simply find out, the point's 
coordinates within the document's default axis-system.
If you create a point using the coordinates method and an axis system is already defined and set as 
current, the point's coordinates are defined according to current the axis system. As a consequence, the 
point's coordinates are not displayed in the specification tree.

The axis system must be 
different from the absolute 
axis.
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On curve 
●     Select a curve

●     Optionally, select a 
reference point.

If this point is not on 
the curve, it is 
projected onto the 
curve.
If no point is 
selected, the curve's 
extremity is used as 
reference.

 

●     Select an option point to 
determine whether the new 
point is to be created: 

❍     at a given distance 
along the curve from 
the reference point

❍     a given ratio between 
the reference point and 
the curve's extremity.

    

●     Enter the distance or ratio 
value.
If a distance is specified, it 
can be: 

❍     a geodesic distance: the 
distance is measured 
along the curve

❍     an Euclidean distance: 
the distance is 
measured in relation to 
the reference point 
(absolute value).

The corresponding point is 
displayed.



If the reference point is located at the curve's extremity, even if a ratio value is defined, the created 
point is always located at the end point of the curve.

You can also: 
●     click the Nearest extremity button to display the point at the nearest extremity of the curve.

●     click the Middle Point button to display the mid-point of the curve.

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not closed) 
when using the Middle Point option.

●     use the Reverse Direction button to display: 
❍     the point on the other side of the reference point (if a point was selected originally)

❍     the point from the other extremity  (if no point was selected originally).

●     click the Repeat object after OK if you wish to create equidistant points on the curve, using the 
currently created point as the reference, as described in Creating Multiple Points in the Wireframe 
and Surface User's Guide. 

You will also be able 
to create planes 
normal to the curve 
at these points, by 
checking the Create 
normal planes also 
button, and to create 
all instances in a new 
geometrical set  by 
checking the Create 
in a new 
geometrical set 
button.
If the button is not 
checked the 
instances are created 
in the current 
geometrical set .

 

●     If the curve is infinite and no reference point is explicitly given, by default, the reference point is the 
projection of the model's origin

●     If the curve is a closed curve, either the system detects a vertex on the curve that can be used as a 
reference point, or it creates an extremum point, and highlights it (you can then select another one if 
you wish) or the system prompts you to manually select a reference point.

 

Extremum points created on a 
closed curve are now 
aggregated under their parent 
command and put in no show in 
the specification tree.



On plane 
●     Select a plane.

●     Optionally, select a point to 
define a reference for 
computing coordinates in 
the plane.

If no point is 
selected, the 
projection of the 
model's origin on the 
plane is taken as 
reference. 

  

 
●     Optionally, select a surface 

on which the point is 
projected normally to the 
plane.

If no surface is 
selected, the 
behavior is the same.

Furthermore, the 
reference direction 
(H and V vectors) is 
computed as 
follows: 
With N the normal to 
the selected plane 
(reference plane), H 
results from the 
vectorial product of Z 
and N (H = Z^N). 
If the norm of H is 
strictly positive then 
V results from the 
vectorial product of N 
and H (V = N^H).
Otherwise, V = N^X 
and H = V^N.

Would the plane 
move, during an 
update for example, 
the reference 
direction would then 
be projected on the 
plane. 



●     Click in the plane to display a point.

On surface 
●     Select the surface where 

the point is to be created.

 

●     Optionally, select a 
reference point. By default, 
the surface's middle point is 
taken as reference. 

●     You can select an element 
to take its orientation as 
reference direction or a 
plane to take its normal as 
reference direction.
You can also use the 
contextual menu to specify 
the X, Y, Z components of 
the reference direction.

●     Enter a distance along the 
reference direction to 
display a point.

 
    

Circle/Sphere center 
●     Select a circle, circular arc, 

or ellipse, or

●     Select a sphere or a portion 
of sphere.



A point is displayed 
at the center of the 
selected element.

    

Tangent on curve 
●     Select a planar curve and a 

direction line.

A point is displayed 
at each tangent. 

    

The Multi-Result 
Management dialog 
box is displayed 
because several 
points are 
generated. 

●     Click YES: you can then 
select a reference element, 
to which only the closest 
point is created.

●     Click NO: all the points are 
created.

For further information, refer to 
the Managing Multi-Result 
Operations chapter.

Between
●     Select any two points.
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●     Enter the ratio, that is the 
percentage of the distance 
from the first selected 
point, at which the new 
point is to be.
You can also click Middle 
Point button to create a 
point at the exact midpoint 
(ratio = 0.5).

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not closed) 
when using the Middle Point option.

●     Use the Reverse direction 
button to measure the ratio 
from the second selected 
point.

 
If the ratio value is greater than 1, the point is located on the virtual line beyond the selected points.

3.  Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing Parameters 
chapter.

●     You can isolate a point in order to cut the links it has with the geometry used to create it. To do so, 
use the Isolate contextual menu. For more information, refer to the Isolating Features chapter.
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Creating Lines

This task shows the various methods for creating lines: 

●     point to point

●     point and direction

●     angle or normal to curve

●     tangent to curve

●     normal to surface

●     bisecting

 
It also shows you how to create a line up to an element, define the length type and automatically 
reselect the second point.

 
Open the Lines1.CATPart document.

1.  Click the Line icon  .

The Line Definition dialog box is displayed. 

2.  Use the drop-down list to choose the desired line type.

 
A line type will be proposed automatically in some cases depending on your first element selection.

 

Defining the line type
 

Point - Point 

 
This command is only available with the 
Generative Shape Design 2 product.

●     Select two points.
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A line is displayed between the two 
points.
Proposed Start and End points of the 
new line are shown.

●     If needed, select a support surface.
In this case a geodesic line is created, i.e. 
going from one point to the other according to 
the shortest distance along the surface 
geometry (blue line in the illustration below).
If no surface is selected, the line is created 
between the two points based on the shortest 
distance.

If you select two points on closed surface (a 
cylinder for example), the result may be unstable. 
Therefore, it is advised to split the surface and only 
keep the part on which the geodesic line will lie. 

 
The geodesic line is not available with the Wireframe and Surface workbench.



 
●     Specify the Start and End points of the new line, that is the line endpoint location in relation to the 

points initially selected. These Start and End points are necessarily beyond the selected points, 
meaning the line cannot be shorter than the distance between the initial points.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start 
and End points.

 
The projections of the 3D point(s) must already exist on the selected support. 

Point - Direction 
 

●     Select a reference Point and a Direction line.
A vector parallel to the direction line is 
displayed at the reference point. 
Proposed Start and End points of the new line 
are shown.



●     Specify the Start and End points of the new 
line.
The corresponding line is displayed.

 
The projections of the 3D point(s) must already exist on the selected support. 

  

Angle or Normal to curve
 

●     Select a reference Curve and a Support 
surface containing that curve.



- If the selected curve is planar, then the 
Support is set to Default (Plane).

- If an explicit Support has been 
defined, a contextual menu is available 
to clear the selection.

 
●     Select a Point on the curve.

●     Enter an Angle value.

A line is displayed at the given angle 
with respect to the tangent to the 
reference curve at the selected point. 
These elements are displayed in the 
plane tangent to the surface at the 
selected point. 
You can click on the Normal to Curve 
button to specify an angle of 90 
degrees. 
Proposed Start and End points of the 
line are shown. 

●     Specify the Start and End points of the new line.
The corresponding line is displayed.



●     Click the Repeat object after OK if you wish 
to create more lines with the same definition as 
the currently created line. 
In this case, the Object Repetition dialog box is 
displayed, and you key in the number of 
instances to be created before pressing OK.

As many lines as indicated in the dialog box are 
created, each separated from the initial line by a 
multiple of the angle value.

 

You can select the Geometry on Support check box if you want to create a geodesic line onto a support 

surface. 

The figure below illustrates this case.

 

Geometry on support option not checked Geometry on support option checked

 
This line type enables to edit the line's parameters. Refer to Editing Parameters to find out how to 
display these parameters in the 3D geometry.
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Tangent to curve
 

●     Select a reference Curve and a point or 
another Curve to define the tangency. 

❍     if a point is selected (mono-tangent mode): 
a vector tangent to the curve is displayed 
at the selected point.

❍     If a second curve is selected (or a point in 
bi-tangent mode), you need to select a 
support plane. The line will be tangent to 
both curves.

 - If the selected curve is a line, then the 
Support is set to Default (Plane).

- If an explicit Support has been 
defined, a contextual menu is available 
to clear the selection.

 When several solutions are possible, you 
can choose one (displayed in red) 
directly in the geometry, or using the 
Next Solution button.

     

 

 

Line tangent to curve at a given point Line tangent to two curves
●     Specify Start and End points to define the new line.

The corresponding line is displayed.



 

Normal to surface 
 

●     Select a reference Surface and a Point.
A vector normal to the surface is displayed at 
the reference point. 
Proposed Start and End points of the new line 
are shown.

 If the point does not lie on the support surface, the minimum distance between the point and the surface 
is computed, and the vector normal to the surface is displayed at the resulted reference point.



●     Specify Start and End points to define the new 
line.
The corresponding line is displayed.



 

●     Select the support surface onto which the 
bisecting line is to be projected, if needed.

●     Specify the line's length in relation to its 
starting point (Start and End values for each 
side of the line in relation to the default end 
points).
The corresponding bisecting line, is displayed.

●     You can choose between two solutions, using 
the Next Solution button, or directly clicking 
the numbered arrows in the geometry.

Bisecting 
 

●     Select two lines. Their bisecting line is the line 
splitting in two equals parts the angle between 
these two lines. 

●     Select a point as the starting point for the line. 
By default it is the intersection of the bisecting 
line and the first selected line.



3.  Click OK to create the line.

The line (identified as Line.xxx) is added to the specification tree.

  ●     Regardless of the line type, Start and End values are specified by entering distance values or by 
using the graphic manipulators.

●     Start and End values should not be the same.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected Start 
point. 
It is only available with the Length Length type.

●     In most cases, you can select a support on which the line is to be created. In this case, the selected 
point(s) is projected onto this support.

●     You can reverse the direction of the line by either clicking the displayed vector or selecting the 
Reverse Direction button (not available with the point-point line type).

     

Creating a line up to an element
 This capability allows you to create a line up to a point, a curve, or a surface.

●     It is available with all line types, but the Tangent to curve type.

 

Up to a point
●     Select a point in the Up-to 1 and/or Up-to 2 

fields.

Here is an example with the Bisecting line type, 
the Length Length type, and a point as Up-to 
2 element.



 

Up to a curve
●     Select a curve in the Up-to 1 and/or Up-to 2 

fields.

Here is an example with the Point-Point line 
type, the Infinite End Length type, and a 
curve as the Up-to 1 element.

 

Up to a surface
●     Select a surface in the Up-to 1 and/or Up-to 2 

fields.

Here is an example with the Point-Direction line 
type, the Length Length type, and the surface 
as the Up-to 2 element.

  
●     If the selected Up-to element does not intersect with the line being created, then an extrapolation is 

performed. It is only possible if the element is linear and lies on the same plane as the line being 
created.
However, no extrapolation is performed if the Up-to element is a curve or a surface.

●     The Up-to 1 and Up-to 2 fields are grayed out with the Infinite Length type, the Up-to 1 field is 
grayed out with the Infinite Start Length type, the Up-to 2 field is grayed out with the Infinite End 
Length type.

●     The Up-to 1 field is grayed out if the Mirrored extent option is checked.

●     In the case of the Point-Point line type, Start and End values cannot be negative.

  
 

Defining the length type



 ●     Select the Length Type: 
❍     Length: the line will be defined according to the Start and End points values

❍     Infinite: the line will be infinite

❍     Infinite Start Point: the line will be infinite from the Start point

❍     Infinite End Point: the line will be infinite from the End point

By default, the Length type is selected.
The Start and/or the End points values will be greyed out when one of the Infinite options is chosen.

  
 

Reselecting automatically a second point

This capability is only available with the Point-Point line method.

1.  Double-click the Line icon .

The Line dialog box is displayed.

2.  Create the first point.

 

The Reselect Second Point at next start option 
appears in the Line dialog box.

3.  Check it to be able to later reuse the 

second point.

4.  Create the second point.

5.  Click OK to create the first line.

  



 

The Line dialog box opens again with the 
first point initialized with the second 
point of the first line.

6.  Click OK to create the second line.

 To stop the repeat action, simply uncheck the option or click Cancel in the Line dialog box.
  

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing Parameters 
chapter.

●     You can isolate a line in order to cut the links it has with the geometry used to create it. To do so, 
use the Isolate contextual menu. For more information, refer to the Isolating Features chapter.
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Creating Planes

 
This task shows the various methods for creating planes:

 

●     offset from a plane

●     parallel through point

●     angle/normal to a plane

●     through three points

●     through two lines

●     through a point and a line

●     through a planar 
curve

●     normal to a curve

●     tangent to a surface

●     from its equation

●     mean through points

 

 
Open the Planes1.CATPart document.

 
1.  Click the Plane icon  .

The Plane Definition dialog box appears.

2.  Use the combo to choose the desired Plane type.

 
Once you have defined the plane, it is represented by a red square symbol, which you can move using 
the graphic manipulator.

Offset from plane

●     Select a reference Plane then enter an 
Offset value.

A plane is displayed offset from the reference 
plane.
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Use the Reverse Direction button to  reverse 
the change the offset direction, or simply click 
on the arrow in the geometry.

      
●     Click the Repeat object after OK if you wish to 

create more offset planes . 
In this case, the Object Repetition dialog box is 
displayed, and you key in the number of instances to 
be created before pressing OK.

As many planes as indicated in the dialog box 
are created (including the one you were 
currently creating), each separated from the 
initial plane by a multiple of the Offset value. 

 

Parallel through point 

●     Select a reference Plane and a Point.



A plane is displayed parallel to the reference 
plane and passing through the selected point.

Angle or normal to plane 

●     Select a reference Plane and a Rotation 
axis.
This axis can be any line or an implicit 
element, such as a cylinder axis for 
example. To select the latter press and hold 
the Shift key while moving the pointer over 
the element, then click it.

●     Enter an Angle value.

 



A plane is displayed passing through the 
rotation axis. It is oriented at the specified 
angle to the reference plane. 

●     Click the Repeat object after OK if you wish to create more planes at an angle from the initial 
plane. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of instances 
to be created before pressing OK.

As many planes as indicated in the dialog box 
are created (including the one you were 
currently creating), each separated from the 
initial plane by a multiple of the Angle value.

Here we created five planes at an angle of 20 
degrees.

 This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find out how to 
display these parameters in the 3D geometry.

Through three points 

●     Select three points.
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The plane passing through the three points is 
displayed. You can move it simply by dragging it 
to the desired location.

Through two lines 

●     Select two lines.

The plane passing through the two line 
directions is displayed.
When these two lines are not coplanar, the 
vector of the second line is moved to the first 
line location to define the plane's second 
direction. 



Check the Forbid non coplanar lines button to specify that both lines be in the same plane.

Through point and line 

●     Select a Point and a Line.

The plane passing through the point and the line 
is displayed. 

 



Through planar curve 

●     Select a planar Curve.

The plane containing the curve is displayed.

Tangent to surface 

●     Select a reference Surface and a Point.



A plane is displayed tangent to the surface at 
the specified point.

Normal to curve 

●     Select a reference Curve.

●     You can select a Point. By default, the 
curve's middle point is selecte.



A plane is displayed normal to the curve at the 
specified point. 

Mean through points 

●     Select three or more points to display the 
mean plane through these points.

It is possible to edit the plane by first selecting 
a point in the dialog box list then choosing an 
option to either:

●     Remove the selected point

●     Replace the selected point by another 
point.



Equation 

●     Enter the A, B, C, D components of the Ax 
+ By + Cz = D plane equation.

 

Select a point to position the plane through this 
point, you are able to modify A, B, and C 
components, the D component becomes grayed.

 

Use the Normal to compass button to position 
the plane perpendicular to the compass 
direction.

Use the Parallel to screen button to parallel to 
the screen current view.



3.  Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.
  

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing Parameters 
chapter.

●     You can isolate a plane in order to cut the links it has with the geometry used to create it. To do so, 
use the Isolate contextual menu. For more information, refer to the Isolating Features chapter.
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Displaying Characteristic Curves

This task shows you how to manage characteristic curves. 
Characteristic curves are displayed in the folded view of the part, as well as in the flattened view. They 
can be selected, though not edited, and be used as a support (to create points for example), 

A surfacic flange or a stamp with a fillet must be created.

 The following curves can be computed:
●     OML: Outer Mold Line

Intersection between external surfaces of the feature (before filleting) and the part

●     IML: Inner Mold Line
Intersection between internal surfaces of the feature (before filleting) and the part
Computed only on a hydropressed flange

●     BTL: Bent Tangent Line
Limits of the fillet

 They must be computed on the following features:
●     Surfacic Flange: the following curves are computed on both folded and flattened view (as defined 

in the Process tab of the Surfacic Flange Definition dialog box)

❍     BTL (two BTL for each limit of the fillet)

❍     OML

❍     IML

●     Stamps with an internal cutout (flanged hole, flanged cutout, etc): the following curves are 
computed on both folded and flattened view

❍     BTL on the base feature 

❍     IML (in no show in the folded view)

❍     OML (in no show in the folded view)

●     Stamps without an internal cutout (bead, curve stamp, etc): the following curve is computed 
on both folded and flattened view

❍     BTL on the base feature

Open the CharacteristicCurves1.CATPart document.

 Here is an example with two surfacic flanges, a bead and a flanged hole.
All characteristic curves are put in show in the following images.

Characteristic curves computed on the folded view
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Characteristic curves computed on the flattened view

 



   

If you want to edit and modify a curve color, select it in the 3D geometry, right-click and choose the 

Properties contextual command. In the Properties dialog box, select the Graphic tab to access the 

graphic properties of the curve.



Looking For Aerospace SheetMetal Features

This task shows how to use the Search capabilities on Aerospace SheetMetal Features, in order to detect 
any specific kind of feature.

Open the PowerCopyStart.CATPart document.

1.  Select the Edit ->  Search menu item.

The Search dialog box is displayed. 

2.  From the Type Workbench list choose Sheet Metal.

You can then display the list of Aerospace Sheet Metal Design features from the Type list: 
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3.  Select the type of feature you wish to find within the open .CATPart document. 

Here we chose Joggle.

4.  Click the Search button.

The list of all elements of the selected type is displayed in the Objects found field:

You can select an element from the list, it will be highlighted in the geometry area.
To find out more on the search capabilities, refer to Selecting Using the Search... Command (General 
Mode) and Selecting Using the Search... Command (Favorites and Advanced Modes) from the 
Infrastructure User's Guide.

 



Browsing the SheetMetal Catalog

This task explains how to browse the SheetMetal catalog and instantiate its components. The catalog enables 
to store the available profiles, therefore providing a method to position the profile in the part. 
This command is available with the CutOut and the Corner Relief functionalities.  

Let's take an example with the CutOut functionality.
For more information on catalogs, please refer to the Using Catalogs chapter in the CATIA Infrastructure User 
Guide.

Open the CutOut1.CATPart document.

1.  Once in the 

CutOut Definition 

dialog box, click 

the Catalog icon 

.

 
2.  Double-click a family from the list to display its components.

Here we chose the UserFeature_Family.
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3.  Click a 

component to 

see its preview.

Here we chose 

Slot_Contour.

 
4.  Click the Table>> button to show/hide the catalog descriptions and keywords. By default, the table is 

hidden.

 

5.  Instantiate the 

component by 

double-clicking 

it.

 



The Insert Object dialog box is displayed.
 

6.  Select the 

required inputs: 

plane, point, and 

axis.

7.  Click Preview to 

see the resulting 

profile in the 3D 

geometry.

8.  Click OK in the 

Insert dialog 

box.



The selected profile 
appears in the Selection 
field.

 

9.  Click OK.

 

The created element (identified as Cutout.xxx) is added to the specification tree.

You may need to reverse the direction of the cutout to create it.

Once the profile is instantiated in the default catalog, its path is automatically set in the Standard Profiles 
Catalog Files field.
See Customizing General Settings.

 A new panel now allows you to select alternate document access methods. 
See Opening Existing Documents Using the Browse Panel in CATIA Infrastructure User Guide.

 



Integration With Part Design

You can open the Integration1.CATPart document.

In a CATPart document, you may have Part Design features and Aerospace Sheet Metal features 
according to the following rules:

●     Part Design features can be created before Aerospace Sheet Metal features.

●     a Part Design feature can also be created after Aerospace Sheet Metal features as long as 
the part is in folded view.

●     in the unfolded view, the Part Design feature will not be displayed.

●     it is no longer possible to create Aerospace Sheet Metal features after this last Part Design 
feature in folded view.

1.  Create a web and a flange.

2.  Switch to Part Design workbench.

3.  Launch the Sketcher and draw an oblique line in the yz plane.

4.  Click the icon  to create a Stiffener.

5.  Switch to the Aerospace Sheet Metal workbench.

6.  Click the Unfold icon .
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The stiffener is not displayed on the unfolded view.

To add a new Aerospace Sheet Metal feature, select the Flange for example and right-click the Define In 
Work Object item.

The new Aerospace  Sheet Metal feature will be added after the Flange but before the Stiffener.



Workbench Description
The Aerospace Sheet Metal Design application window looks like this:
Click the hotspots to display the related documentation. 

 

Menu Bar
Aerospace SheetMetal Toolbar

Stampings Toolbar
Constraints Toolbar

Reference Elements Toolbar
Specification Tree 

 



Menu Bar

The various menus and menu commands that are specific to Aerospace Sheetmetal Design are described 
below.

 

Start File Edit View Insert Tools Windows Help

Tasks corresponding to general menu commands are described in the Infrastructure User's Guide. Refer to the 
Menu Bar section. 

Edit 

The Edit menu lets you manipulate selected objects. Refer to the Infrastructure User's Guide and Part Design 
User's Guide. 

View 

The View menu lets you view document contents  Refer to the Infrastructure User's Guide.

The Search capability is available.

 

Insert 
For... See...

ContainerSketcherMenu Refer to the Sketcher User's Guide.

Sheet Metal 
Parameters...

Managing the Default Parameters

Web... Creating a Web

Surfacic Flange... Creating a Surfacic Flange

Joggle... Creating a Joggle

Swept Walls Insert -> Swept Walls

Fold/Unfold views 
management

Insert -> Unfold



CutOut... Creating a Cutout

Hole... Creating a Hole

Stampings Insert -> Stampings

Corner Relief... Creating a Local Corner Relief

Shape Mapping Mapping Elements 

Corner/Chamfer Insert -> Corner/Chamfer 

Pattern Insert -> Pattern 

Constraint Setting Constraints in the Part Design 
User's Guide

Insert -> Swept Walls
 For... See... 

Flange Creating a Flange

Hem Creating a Hem

Tear Drop Creating a Tear Drop

User Flange Creating a Swept Flange

Insert -> Unfold
For... See... 
Unfold... Folded/Unfolded View Access

Multi Viewer... Concurrent Access

Insert -> Stampings

file:///E|/Www/cnqr14/Doc/online/prtug_C2/prtugbt1100.htm


For... See... 
Flanged Hole... Creating a Flanged Hole

Bead... Creating a Bead

Circular Stamp... Creating a Circular Stamp 

Surface Stamp... Creating a Surface Stamp

Flanged CutOut... Creating a Flanged Cutout

Curve Stamp... Creating a Curve Stamp

Stiffening Rib... Creating a Stiffening Rib 

User Stamp... Creating User-Defined Stamping Features

 Insert -> Corner/Chamfer
 For... See...

Corner... Creating Corners 

Chamfer... Creating Chamfers 

Insert -> Pattern
 For... See...

Rectangular Pattern... Creating Rectangular Patterns 

Circular Pattern... Creating Circular Patterns 

User Pattern... Creating User-Defined Patterns 



Aerospace  SheetMetal Toolbar

  The Aerospace Sheet Metal Toolbar contains the following tools:

  

  

 See Managing the Default Parameters

 See Creating a Web

 See Creating a Surfacic Flange

 See Creating a Joggle

 See Creating Swept Walls

 See Unfolding the Part

 See Creating a Cutout

 See Creating a Hole

 See Creating Stamping Features

 See Creating a Corner Relief

  See Mapping Elements  



  
See Creating Corners 
See Creating Chamfers 

 

  See Creating Patterns 

 

 



Stampings Toolbar
The Stampings toolbar contains the following tools:

 

   

    
 

See Creating a Flanged Hole

  See Creating a Bead

 See Creating a Circular Stamp

 
 

See Creating a Surface Stamp

 See Creating a Flanged Cutout

  See Creating a Stiffening Rib 

 See Creating a Curve Stamp

 See Creating User-Defined Stamping Features



Constraints Toolbar

  The Constraints Toolbar contains the following tools:

 

  

  
See Setting Constraints from the Part Design User's Guide
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Reference Elements Toolbar

  The Reference Elements Toolbar contains the following tools:

 

   

 See Creating Points

 See Creating Lines

 See Creating Planes

 



Specification Tree
Within the Aerospace Sheetmetal Design workbench, you can generate a number of features that are identified 
in the specification tree by the following icons.

Further information on general symbols in the specification tree are available in Symbols Used in the 
Specification Tree.

Sketch Corner Relief

Sheet Metal Parameters
 
Mapping 

Web
 
Corner 

Surfacic Flange
 

Chamfer 

Joggle
 

Rectangular Pattern 

Flange
 

Circular Pattern 

Hem  User-Defined Pattern 

Tear Drop Point

Swept Flange Line

Cutout Plane

Hole   

Flanged Hole   

Bead   

Circular Stamp   

Surface Stamp   

file:///E|/Www/cnqr14/Doc/online/cfyugprt_C2/cfyugsymbol1.htm
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Flanged Cutout   

Curve Stamp   

 
Stiffening Rib   



Customizing
This section describes how to customize standards files and settings specific to the Aerospace Sheet Metal 
Design workbench. 

Aerospace Sheet Metal Design
Customizing Standards Files to Define Design Tables

Customizing Standards Files to Define Methods for Compensations 



Aerospace Sheet Metal Design
 

 
This page deals with the following category of options in the Aerospace Sheet Metal Design tab: 
Standard Profiles Catalog File.

Standard Profiles Catalog File

Enter the default path in this field. You may click the Browse icon .

  By default, this field is empty.

If no catalog path has been defined prior to entering the Catalog Browser command, the default catalog 

is selected and its path is automatically added to the Standard Profiles Catalog File field.



Customizing Standards Files
to Define Design Tables

This section describes how to customize company standards files to define design tables.

To know more about the different ways to access you files, refer to the Opening Existing Documents Using the Browse Window 
section.

Using Sheet Metal Standards Files

This task explains how to access company standards files in order to access and define design tables.

Open a new document.

1.  Click the Sheet Metal Parameters icon .

The Sheet Metal Parameters dialog box opens.

 

2.  Select the 

Sheet 

Standards 

Files... 

button. The 

File Selection 

window is 

displayed.

3.  Indicate the 

path to the 

Sheet Metal 

table.

These files are available under .txt format or .xls format (only for Windows)

file:///E|/Www/cnqr14/Doc/online/cfyugbas_C2/cfyugbrowsewindow.htm


4.  Click Open.

In the 
Sheet Metal 
Parameters 
dialog box, 
the Design 
Table icon 

 

appears 
opposite 
the 
Thickness 
and Bend 
radius 
fields.

The parameters are now in gray, indicating that you can no longer modify the values.

5.  Click the 

Thickness 

Design Table 

icon  and 

select the line 

containing the 

appropriate 

parameters 

(for example 

Line 1).

Using the Tools -> Options -> General -> Document tab, Other Folders option, you can specify where the files are located. 
Refer to Document. 
This scenario can work when the .CATPart document and all reference table files (Design & Radius) are located in the same 
directory. This directory is the current one when the Design table is created, and also when the .CATPart is open.
However, generally speaking,  you must reference the complete path indicating where the radius table files are to be found in 
the RadiusTable column. In this case, regardless of the current directory, the correct tables are located when re-opening the 
.CATPart document.

6.  Click OK.

The parameter values are updated in the Sheet Metal Parameters dialog box.

7.  Click the Bend 

Radius Design 

Table icon 

.

8.  Select line 2 

and click OK. 

The parameter 

values are 



updated in the 

Sheet Metal 

Parameters 

dialog box.

9.  Create a 

flange.

The Flange 

definition 

dialog box 

reflects the 

modification 

for the 

Radius.

The default 

mode, that 

is to say 

the 

formula:

Bend 

Radius = 

Part 

Radius is 

deactivated.

Using the Sheet Metal Design Tables:

Steps 1 to 4 are 
identical. 

5.  Click the 

Design Table 

icon  and 

select a line.

6.  Click OK.

The parameter values are updated in the Sheet Metal Parameters dialog box.



 
At that time, the parameters Thickness and Bend radius are driven by the design table.

They are now in gray, indicating that you can no longer modify the values.

Note that if you create a bend, there is no design table: it's the formula which is used.

 
To disable the access to design tables:

●     Select the Tools -> Options -> Part -> Display tab and check Relations: the Design Table icon  is displayed in the 

specification tree.

●     Right-click this icon: the contextual menu appears.

●     Select SheetMetal Thickness Table object -> Deactivate 

The relation is no longer used but still exists. It can be activated at any time.

 

 



Customizing Standards Files
to Define Methods for Compensations

This task explains how to access company standards files (available in .xls format) in order to define methods for joggle and sides 

compensations. The methods described in this task apply to joggles relying on a flange with a base feature (either a web or a flange) without 

joggles.

Open a new document.

  

1.  Click the Sheet Metal Parameters icon . The Sheet Metal Parameters dialog box is displayed.

2.  Select the Sheet Standards Files... button. The File Selection window is displayed.

3.  Indicate the path to the Sheet Metal methods (Std_Method1.xls or Std_Method1_2.xls). 

 Two methods are available to enable the joggle compensations. Both use Design Tables.
 

Method 1

This method is the method which was used in V4.

 The type of modifications performed depends on the position of the joggle with regards to:
●     the end of the part:

❍     near the end of part (case 1)

❍     not near the end of part (case 2)

●     the position of other joggles:
❍     twin joggles (case 3)

❍     double joggle near the end of part (case 4)

❍     double joggle not near the end of part (case 5)

How the different cases and the deformation are managed

Six values are used in the following description: C1, C2, C3, C4, C5, Ra. These values are defined in a design table. The path to this design table 
is defined in the Std_Method1.xls file.

Here is an example of a design table:
 C1 C2 C3 C4 C5 Ra

75 5 150 10 75 3

 
  
 Case 1



 

 
●     The parameters necessary for performing the modifications are as follows:

❍     The parameter of the feature is: S (joggle depth) 

❍     Some values are computed to define the type of deformation: alpha, X.

●     The parameter definition and links are as follows:
❍     This case is applied if X < C1.

❍     C1 is defined with a constant value.

●     This deformation is performed as follows:
❍     The alpha angle is computed from S and X ( tangent(alpha) = S / X ). 

❍     The side and the EOP are then rotated with the alpha angle. The center of rotation is the intersection between the BTL on the flange and 
the side. 

 Case 2

 

 
●     The parameters necessary for performing the modifications are as follows:

❍     The values of the modification are: C1, Ra.

●     The parameter definition and links are as follows:
❍     This case is applied if X > C1.

❍     C1 is defined with a constant value.

❍     Ra is defined with a constant value.

 Case 3

 



 
●     The parameters necessary for performing the modifications are as follows:

❍     The values of the modification are: C2, C3, C4, Ra.

❍     A value is computed to define the type of deformation (table) to apply: X.

●     The parameter definition and links are as follows:
❍     This case is applied if C3 > X > C2.

❍     Then: a = (X - C4) / 2.

❍     C2, C3 and C4 are defined with a constant value.

❍     Ra is defined with a constant value.

 Case 4

This case applies only to the joggle positioned on the right; the joggle positioned on the left follows case 1.

 

 
●     The parameters necessary for performing the modifications are as follows:

❍     A value is computed to define the type of deformation (table) to apply: X.

●     The parameter definition and links are as follows:
❍     This case is applied if C4 > X.

❍     C4 is defined with a constant value.

 Case 5

This case applies only to the joggle positioned on the right; the joggle positioned on the left follows case 2.

 

 
●     The parameters necessary for performing the modifications are as follows:

❍     A value is computed to define the type of deformation (table) to apply: X.

●     The parameter definition and links are as follows:
❍     This case is applied if C5 > X.

❍     C5 is defined with a constant value.

  
 

Method 2



 

 
●     The parameters necessary for performing the modifications are as follows:

❍     Input parameters for joggle compensation:
■     Material Thickness: t

■     Joggle parameters: S (joggle depth)

■     Distance between the joggle and the side of the flange: X

❍     Output parameters:
■     Offset from start of joggle: a

■     Offset from end of joggle: b

■     Flange side compensation: A

■     Radius on start and end of joggle compensation: Ra, Rb

●     The parameter definition and links are as follows:
❍     A, a, b, Ra, Rb are defined from two design tables. The paths to these design tables are defined in the Std_Method1_2.xls file. 

Std_Method1_2.xls also contains the path to each defined thickness.

For each value of a material (therefore for each thickness) in Std_Method1_2.xls, two tables defining compensation values may be 
defined:

A first table defining A, depending on S:
 

SMax a b Ra Rb

0.8 a (0.8) b (0.8) Ra (0.8) Rb (0.8)

1.1 a (1.1) b (1.1) Ra (1.1) Rb (1.1)

1.5 a (1.5) b (1.5) Ra (1.5) Rb (1.5)

 The first line should read as follows: if (0<SMax≤0.8) then a=a (0.8); b=b(0.8); Ra=Ra (0.8) and Rb=Rb (0.8)
The third line should be read as follows: if (1.1<SMax≤1.5) then a=a (1.5); b=b(1.5); Ra=Ra (1.5) and Rb=Rb (1.5)
 

 A second table defining A, depending on S and X:

 

SMax XMax A

0.8 X (0.8) A (0.8)

0.8 X' (0.8) A (0.8)

0.8 X" (0.8) A (0.8)

1.1 X (1.1) A (1.1)



1.1 X' (1.1) A (1.1)

1.1 X" (1.1) A (1.1)

 The first line should be read as follows: if (0<SMax≤0.8) and (0<XMax≤X(0.8)) then A=A (0.8)
The fourth line should be read as follows: if (0.8<SMax≤1.1) and (X" (0.8)<XMax≤X(1.1)) then A=A (1.1)

Definition of Side Compensation
   

 
●     The parameters necessary for performing the modifications are as follows:

❍     The values of the modification are: A1, A2

❍     The type of compensation can be: 
■     None: no compensation is applied

■     Automatic (for symmetric flanges): A1 = A2, so that the length of the flatten eop = the length of the folded eop

■     Manual: Angle: the deformation is computed according to an angle

■     Manual: Length: the deformation is computed according to a length parallel to the btl.

 
4.  Choose the appropriate type of compensation.

 
5.  Click Ok.

In the Sheet Metal Parameters dialog box, if you chose Method 2, the Design Table icon  appears opposite the Thickness field. 

You can click this icon to edit the design table.



Glossary

           

B
bead A local deformation in the web or a flange.

bend A feature joining two walls

C
corner relief A feature defined on two flanges, which forms a corner. 

It relimits the two flanges and redefines the outer profile of the web between the two 
flanges.

cutout A feature corresponding to an opening through a feature.
The shape of the opening corresponds to the extrusion of a profile.

D
depth Dimension specifying the geometry of a bead or a joggle.

E
edge of part Element (usually a curve), which defines the length/height of a surfacic flange.

F
feature Characteristic form. Features are used to define a part.

flange A feature created by sweeping a profile along a spine.
The different flanges or swept walls available are: simple and swept flange, hem and tear 
drop.

J
joggle Feature which causes the flange to be locally deformed.

Usually because the skin which is connected to the web is locally enforced by a strip or 
stringer (L or T profile).

K



K factor Determines the computation of the unfolded length of the surfacic flanges.

P
pattern A set of similar features repeated in the same feature or part.

profile An open or closed profile including arcs and lines created by the Profile command in the 
Sketcher workbench

S
 

stamping A feature created by embossing sheet metal.
The different stampings available are:
bead, circular, flanged hole, flanged cutout, curve, surface, and stiffening rib.

surfacic flange A feature along the outer section of the web or an existing flange. It is used to connect to 
another product or to stiffen the part.

W
web Main constituent of a part. Many other features (flanges, holes, etc.) are defined onto this 

feature.
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